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Preview 

The Epidemiological Interactive System (EPISYS) is a computerized program and database that enables 

researchers to rapidly access, analyze, and summarize large amounts of epidemiological data. This version 

of EPISYS contains inpatient hospitalization, demographic, and career history records for all Navy enlisted 

personnel on active duty between 1 January 1980 and 30 September 1994. The hospitalization data contained 

in EPISYS are obtained from the Naval Medical Information Management Center, Bethesda, Maryland, 

(formally the Naval Medical Data Services Center) and is updated quarterly. Demographic, occupational, 

and other service history information is provided by the Navy Military Personnel Command in Washington, 

DC. 
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System Requirements for Running EPISYS 

v? Any IBM®-compatible machine with a 486 processor or higher. 
<J 65 megabytes of free disk space. 
*# At least 8 megabytes of memory and a 3.5-inch floppy drive. 
«/ Microsoft Windows® Version 3.1 or higher. 
</ Analog, super-VGA compatible monitor. 
</ Mouse or compatible pointing device. 

A laser printer is recommended to print statistical and graphical output. 

Installing EPISYS From the MS-DOS Prompt 

EPISYS executable modules and essential support files are on sixteen 3.5-inch floppy disks. For a 
complete installation all files must be placed on the hard drive according to the following directions: 

CailtiOfl! EPISYS will not overwrite your directories and subdirectories if you have 

previously installed EPISYS on your computer. You will need to delete all 
directories and subdirectories before reinstalling EPISYS.   ":.", 

O    Insert "Disk A" into your floppy drive. 

©    Go to your root directory (cd C:). 

©    Copy the contents of Disk A to your root directory (copy A:*.*). 

&    Insert EPISYS Disk 1 into a floppy drive and type the following command at the MS-DOS 

prompt: Unzip A:episys -d (assuming you put the disk in floppy drive A:) This command will 
create the necessary subdirectories. 

9(pte:     You will be prompted to insert the last disk of the backup set. Insert Disk 16 and press any 

key to continue with the installation. 

©    Follow the instructions on the screen until all of the 16 disks have been loaded. 

©    Exit back to Windows (exit). 

Assigning a Program Group and Icon to EPISYS in Windows 

To run EPISYS from Windows you must first assign a program group and icon to the executable file. 

O    In Program Manager choose New 

from the File menu. 

5                 New Program Object                 1 

New 
©[Program Group! 

O Program item 

OK 

Cancel 

| Help 

Figure 1.1 New Program Object dialog box. 
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©   In the New Program Object dialog 
box, select the Program Group option 
button, and then choose the OK push 
button. 

<=>H^H Program Group Properties  " -         I 

Inscription: 

group File. 

, 
JEPlSYSj        '                                    1 OK —[ 

1                                                          1 Cancel    |. 

Help     | 

Figure 1.2 Program Group Properties dialog box. 

©   In the Description box type EPISYS, then choose the OK push button. 

You will get a blank EPISYS window. 

Figure 1.3 Empty EPISYS program group. 

©    Choose New from the File menu 
again. In the New Program Object dialog box, select the Program Item option button, and then 
choose the OK push button. 

©    The Program Item Properties dialog 
box will appear. In the Description 
box type EPISYS. 

©    In the Command box type 
C:\episys\epimain.exe 

5                                 Program Item Properties                                 1 

ßeicriprjon:               |l                                                |   |        ' OK   *     I 

Sow-andUm*         |                                              |   ( .-Q^.^ 

Working Directory:     |                                                 | 

Shortcut iCe*             JNor»                                        |   1    ft"«»-     1 

n ^™«i™,i»-i • -             I,Sä!äJ 
. j.-- Mik~ j 

Figure 1.4 Program Item Properties dialog box. 

0    Choose the Change Icon... push button. An error message will appear informing you that no 
icons are available for the EPISYS. Choose the OK push button, which will allow you to choose 
an icon from the Program Manager. 

©    Scroll through the icons by clicking the 
scroll arrows or by pressing the Left 
and Right arrow keys on your 
keyboard. Select an icon and press the 
Enter key or choose the OK push 
button. 

£9e N«if!- 

£u»enttcon:   : 
S 

;]IWEJ| ;|^gjj;: 
sjjjome.. 

Help     I 

Figure 1.5 Change Icon dialog box. 

This will return you to the previous dialog box. 
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©    Choose the OK push button. 

Starting EPISYS From Windows 

Before you can start EPISYS from Windows you must follow the steps in the section titled, 
"Assigning a Program Group and Icon to EPISYS in Windows," on page 2. 

O    Double-click 
on the 
EPISYS 
icon. 

Epidemiologies) Interactive System 
EpiSys Database        MuKivariate        Umvariatr        Umte 

The EPISYS 
main menu 
screen will 
appear: 

IQtiltj 

Figure 1.6 Episys main menu screen. 

I$4giz:     When you pull down a menu, you will notice that some commands appear in dark text 
while other are dimmed or grayed. You can use the commands in dark text immediately, 
but you cannot choose the dimmed commands until you defined the database structure arid 
select database options. See Chapter 3, "Setting up the Analysis," to learn how to define 
the database and set the options.       '■[ >■ ■ :;' 

EPISYS Setup 

Before you can run an analysis, you 
must perform a first-time system 
initialization. This will initialize all 
EPISYS variables and tables and 
needs to be performed only once. 

WARNING' 

o 

© 

Choose Initial EpiSys 
Preparation from the EpiSys 
menu. 

i ALL DATA COULD BE LOST!» 

Do You With to Continue? 

«/*" *^No 

Choose the Yes push button if 
EPISYS was newly installed or 

Figure 1.7 Warning screen, 

modified. This option MUST be performed before running an analysis. 
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©    You will get a second warning box. Choose the Yes push button if you wish to continue. 

A third dialog box will appear informing you that initialization is complete. 

©    Choose the OK push button. 

Caution:   Choosing EpiSys Initial Preparation from the EpiSys menu resets EPISYS to an 

initial start-up state. If it is executed, some or all previous analyses might be lost. 

Quitting EPISYS 

You should quit EPISYS before turning off your computer. 

©    Choose Quit from the main menu bar. 

IEPISYS EXIT                                      Eat 1 

(?/    Do You Wish to Leave Episys? 

Yes No          | 

Figure 1.8 EPISYS EXIT dialog box. 

©    Choose the Yes push button. 

In order to avoid a message when you reopen EPISYS you must close JasCapture. 

Follow the steps below: 

O    Point to the camera icon located on the 
bottom of your computer screen and 
click your right mouse button. 

A pop-up menu will appear. 

©    Scroll down with your mouse or use 
your Down arrow key until the option 
Close is highlighted. Release your 
mouse button or press the Enter key. 

Printer Setup 
View Last Capture 
Help 

About 

Close AH+F4 
Figure 1.10 JasCapture pop-up menu. 
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Mouse Techniques 

You will need a mouse to access EPISYS. Some operations will be accessible by both keyboard and 
mouse, however, most operations will only be accessible by mouse. If a function can be performed with 
keystrokes, it will be noted separately. 

Point Move the mouse until the mouse pointer rests on the item you want to select. 

Click Point to an object, then press and release the left mouse button. 

Double-Click Click the left mouse button twice in rapid succession. 

Drag Point to an object. Hold down the left mouse button, move the mouse in the direction 
you want to go, and then release the button. 

Choose Click an item from a menu or dialog box that initiates an immediate action. 

mmmmmfm ^^^^^^^^^^^^^^^^^^^^^^^^r^ST^^m^^^^nr^^^^^j^^^^^T^^i 

9\{bte:     If you are left-handed and you have changed the settings of your mouse to left-handed 
options, you will need to click the right mouse button instead of the left button. 

Keyboard Techniques 

Selecting menus To display pull-down menus from the main screen hold down the Alt key 
and press the mnemonic letter for the menu you want (such as Alt+F for 
the File menu). 

Selecting menu items 

To back out of a menu without choosing an item, press the Esc key 

Use your Up and Down arrow keys until the menu item is highlighted. 
Press the Enter key to accept. 

Menus 

The menus in EPISYS are used sequentially from 
left to right and from top to bottom. EPISYS 
contains six menus. Menu items that are dimmed 
or grayed cannot be used until the submenus 
above it or the menus to the left of it are selected. 

Database 

Select Database Options 

Define Database Structure 
Perform Database Extraction 
Review Database Extraction 

Figure 2.1 Database Menu. 
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EPISYS Menu Options 

Similar commands are grouped under one main menu. The following defines the purpose of each of the six 
main menus in EPISYS. 

Epidemiolooical interactive System 
EpiSys        Database        Multrvariate        Uniyartate   _   Limits        Suit; 

Figure 2.3 EPISYS main menu bar. 

EpiSys 

Database 

Multivariate 

Univariate 

Limits 

Quit 

Displays the EPISYS logo, allows the user to delete an analysis and perform a one-time 
system initialization (the system should only be initialized when the system is first 
installed). 

Allows you to define the Type I error, Mean deviation, and Scaling option and to select and 
extract variables for analysis. 

Allows you to analyze 3 or more dependent variables (illness codes) or groups of illness 
codes. Illness codes can be either Naval Health Research Center (NHRC) or International 
Classification of Diseases, 9lh revision, Clinical Modification (ICD-9-CM) codes. For this 
option to be performed properly you must select three individual illness codes or groups of 
illness codes. EPISYS controls for the variable time by using month of the year as a 
dependent variable. EPISYS automatically factors in month of the year. Independent 
ancillary variables are analyzed for their effects on the dependent variables; these include 
sex, race, age, branch, grade, occupation, platform, and ocean region. EPISYS also allows 
you to determine sampling stratification and sample size allocation. 

Allows you to analyze a single NHRC/ICD-9 code or a single group of illness codes. 
Frequencies and crude and age-adjusted rates are calculated as well as standardized 
incidence ratios. 

Produces time series graphics and written reports indicating time periods when major or 
minor NHRC/ICD-9 category rates exceed expected local or global confidence levels. 

Allows you to safely exit EPISYS. 

Choosing a Menu and Menu Options 

Mouse: 

O    Point to the name of the menu on the main menu bar and click the left mouse button to display the 
pull down menu. 

© Drag the mouse down the list while holding the left mouse button and release when the bar highlights 
the option you want to select. On some menus you may simply click the menu item you want without 
dragging the mouse down the list. 

Keyboard: 

©    Press the Alt key to select the first menu. Then press the Right or Left arrow keys to select other 
menus on the menu bar, or press the Alt key in conjunction with the mnemonic letter of the menu. 

EPISYS Basics 



© Press the Enter key to display the pull-down menu. 

© Us the Up or Down arrow keys to select an option. 

©   Press the Enter key to choose the option. 

Dialog Boxes 

A dialog box appears when you need to supply additional information to complete a task. You can choose 
the Cancel push button or press the Esc key to exit a dialog box without executing the options you 
selected. EPISYS uses four types of data entry inside dialog boxes: Push buttons, Text boxes, Option 
buttons and List boxes. 

IDEFINE DATABASE - NHRC / 1CD9 CODES Mxl 

Enter NHRC or IC09 Code« NHRC /IC09 Code Example« 

' StngtoCode:   1234S 

: Range of Code«   1JM8-1ZK0 

;    »«git Codec:  123" 

II                II                 I 
i         m         i 
i            m            t 

■ i            ii            i Command Push Buttons 

■   i           m           i CODES 
= m                     1 'S                     1 :   • 1             ,   I'l                 1 •   • 

1                  [4                  1 
. . i         r i         t 

'.ext Soxes 

:|/OK' 

i         I«I         i \ 
I              i'l               I    . ^Cancel I 

Figure 2.4 Push buttons and Text boxes. 

'Ngttl     If you change the options to the dialog box and decide you do not want to save them, you 
will need to press the Cancel push button to exit. 

Push Buttons 

Push buttons carry out or cancel a command. For example the OK, Cancel, CODES, and SELECT buttons 
are all examples of push buttons. 

*»    To choose a push button, point with the mouse and click. 

9\0t£:     The currently selected push button has a border that is darker than that of other buttons. 

You can choose the selected button simply by pressing the Enter key 

EPISYS Basics 



Text Box 

Text boxes are used when your information needs to be typed in. 

*■> To input information into the text box, point and click inside the text box and type in the 
desired text or press Tab to move to the box to the right and Shift + Tab if you want to move to 
a box on the left. 

9{giz:    In most cases the cursor will already be positioned in the box. To located the text editing 
cursor, look for a vertical blinking beam. If the box you move to contains text, and the text 
is highlighted, any text you type will replace it. You can also delete the existing text by 
pressing the Delete key or the Backspace key. 

Option Buttons 

Option buttons represent a group of mutually exclusive options. Only one of the options can be selected. 
If you select a second option, your current selection will replace the former. A black dot indicates the item 
is selected. 

■» To select an option button point to the box and click. 

List Boxes 

A list box displays a list of 
choices. Often all of the items 
will not fit inside the window. 
Scroll bars are provided so you 
can move quickly through the list 
box. For help on scrolling a list 
see the following sections.. 

iDEFINE DATABASE - AGE CUSSES jlxj 
- -                                -  • 

Select one of the Categories Below 

Press SEfECTfor Individual Selections 
SELECT 

Age Class Categories 
f                        ... 

'*   Standard Age Classes Separately I^OK 

> Selected Age Classes Separately 

> AH Age Classes Combined IpeEancej 

Figure 2.5 Push buttons and Option buttons. 

DEFINE DATABASE - MAJOR CATEGORIES 

Individual Mi|or C*togor(** 

Choose One or More 

PSESEESSJ 
Uw^ertairtöiotogy; 
Neoptasms 
ErodtoCTingjMutolckwjWtetab^ 
Dtoessea of BlooclJBrOCMfrFormtop Organs 
Mental Disorder« 
Diseases of Nervous Siystem/Sense Orga. 
Dfteasee of Circulatory system 
Diseases of Respiratory System 

Diseases of Genttoarttwry System 
CompJfcatfansefPreofMncy^ChAdbkth   ; 
Wsesscsof $MnJ$ubeuttne*His Tissue ''■■ 
Diseases off Muscotoskelelal System 
Conoenttftl Anamofles 
PertfwtU MorbftWyfttutaMy 
SympfonwticftMleTmed CondKtons 
Accldent*Wsttnina/¥Iolence 
SuppJerncntsrySpectal Condition* 

ffj^aif^i 

F*ae. 

i; 
Scroll Bar 

i^^ 

m BdÄArröw 

Figure 2.6 List box. 
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Scrolling a List and Selecting One Item 

Mouse: 

© Click the Up or Down scroll keys until the item you want appears or move the scroll bar by 
clicking and dragging in the direction you want to go. 

© Click the item. 

Keyboard: 

© Use the mouse to click on the scroll bar. 

© Press the Up or Down arrow key until the bar highlights the option you want to select. 

© Press the Enter key. 

üigte:     Holding down the left mouse button while dragging down the list will cause the scrolling 
\ ■ ::;:";y^ö'cöhto'üe^üntiiteleased.-v'-. 

tJJ^£Li^i^ll^2^-i^!S^^^^i^L-^jj±^i^^rr^.-^..r..> '»«-r—. • '■    -.ww».-.*'.-' , 

Selecting Multiple Items From a Scrolling List 

© If necessary, click the Up or Down scroll arrows until the item you want appears. 

© Select your first item by clicking the left mouse button. 

© Scroll through the list, using the arrows on the side until you find the next item. 

© Hold down the Ctrl key while clicking the left mouse button to select the next item. 

© Repeat until all items are selected. 

Selecting a Block of Sequential Items 

© Hold down the left mouse button and drag across the block of items 
Or: 

© Select the first item by clicking the left mouse button. 

© Scroll through the list, using the arrows on the side until you find the last item of the list you 
would like to select. 

© Hold down the Shift key while clicking the left mouse button. This will paint a block that starts at 
your first item and ends at your last item. 

EPISYS Basics 11 



Canceling an Item From a Group of Selected Items 

Hold down the Ctrl key and click the selected item to cancel. 

9iOtt:    Using the Shift key while clicking the left mouse button only works if the options you 
want to select are in a continuous block. If you would like to select several items that are 
not in a continuous block, use the Ctrl key while clicking the left mouse button for each 

;   selection. 
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Defining the Database Options and Structure for Analysis 

Once you have performed a first-time installation (see Chapter 1, Installation and Setup) you are 
ready to select Database Options (Type I error, Mean deviation, and Scaling option) and Define the 
Database Structure (select variables from the database for analysis). If you extract data without setting 
the database options or defining the database structure you will extract EPISYS default variables (See 
Appendix E for a list of EPISYS default variables) with the Type I error set at .95, mean deviation at 
0.1000 and the scaling option at # per 100,000 person-years at risk. If you want to combine groups of 
illness codes or look at a sub-population you will need to define and extract the variables of interest 
and save this extraction under a file name. 

Selecting Database Options 

You can change the way EPISYS looks at your data by modifying the default options from the 
DATABASE - GLOBAL DEFINITIONS dialog box. The three database options are as follows: 

Type I error Several multi-variate analyzes use statistical tests of significance. If this option 
is not modified, the value .95 will be used for the significance level and 
confidence intervals. 

Mean deviation Determines stratified sample sizes. For instance, a value of 0.100 results in a 
sample size large enough to detect a 10% difference between mean incidence 
rates. The smaller the value, the larger the sample size. 

Scaling option When calculating incidence or prevalence rates this option allows you to change 
the population unit constant (k) from 10 to 100,000 person-years. 

'?~"* •■*» ■■ ■*•»   T^^^^ 

CailtiOti:   Once you have changed the default values in the DATABASE-GLOBAL 

DEFINITIONS dialog box the new value(s) will become the default. 

DATABASE - GLOBAL DEFINITIONS 

Follow the steps below to change the default settings in the DATABASE - GLOBAL DEFINITIONS 
dialog box: 

O    Choose Define Database 
Options from the Database 
menu. 

©    To change the Type 1 error 
and the mean deviation click 
on the box and highlight the 
default value and type in the 
new value. The text you type 
will replace the highlighted 
text. 

©   To change the scaling 
options click on the 
appropriate option button. 
Only one of the options can 
be selected. If you select a 
second option, your current 
selection will replace the 
former. 

Type 1 Error => (L90 - 0.99: 0.9500| i     Ü- 
■ -*?•> injujuigs.' 

^^   f 

Mean Deviation => 0.001 - 0.1000 

Scaling Options - Seiet tOne f^OK 

,> No Scaling Factor                                        / 

> # per 10 Person-Years at Risk                / 

> # per 100 Person-Years at Risk 

> # per 1,000 Person-Years at Risk 

tsr3is 

JKCancd 

/ # per 10,000 Person-Years 

"t   ft per 100,000 Person-Year 

at Risk 

sat Risk 
sill 

Figure 3.1 DATABASE - GLOBAL DEFINITIONS dialog box. 
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0    Choose the OK push button to accept your changes or the Cancel push button if you want to 
keep the default settings, (Type I Error = .95, Mean deviation = .10 and Scaling option = # per 
100,000 person-years at risk). 

^h[pte:    If you enter a value that is out of range for mean deviation and Type 1 error a warning 

message will appear. Click OK or press the Enter key, then enter an appropriate value. The 
range of appropriate values are displayed to the left of the associated text box; 

^äffiWIfi^W^^ 

Defining Database Structure 

When you define the database structure, you are actually changing the default settings for one or all 
of the variables in EPISYS. The default setting for each variable in EPISYS is to extract all variables, 
and look at them separately. See the list of EPISYS variables below: 

List of EPISYS Variables Found in the DATABASE-DEFINITION Dialog Box 

NHRC/ICD-9 Categories 
Naval Health Research Center (NHRC)' 
or ICD-92 illnesses codes are used to 
identify illnesses. For a list of Major and 
Minor categories see Appendix A. 

All Minor Categories Separately 
All Major Categories Separately 
Select Individual Major Categories 
Select Individual Minor categories 
Select Individual NHRC Codes 
Select Individual ICD9 Codes 

Sex Categories 
Male        Female 

Race Categories 
White 
Black 
Other (Includes Filipinos, Asian and 
Native Americans) 

Age classes 
The following is a list of preset age 
classes. The default age classes were based 
on the Surveillance, Epidemiology, and 
End Results3. You can, however, define 
your own age classes. See the section titled 
Defining Age Classes on page 25. 

17-19 20-21 
22-24 25-29 
30-35 35-39 
40-44 45-61 

Service Branches 
United States Navy USN 
United States Marine Corps USMC 

Marine Corps data is not available in 
EPISYS version 1.0. 

Pay Grades 
Enlisted 1-9 

Occupation Rates 
Allows you to select individual occupation 
rate categories 4. For example, 7 800-AN 
Airman. See Appendix C for a list of 
occupational rate codes and titles. 

Duty Platforms 
The UIC type were the person worked 
prior to hospitalization. UIC's are 
organized by the type, e.g., Aircraft 
carrier, Submarine or Ashore (see 
Appendix D for a complete list available 
in EPISYS). 

Ocean Regions 
This is not available in EPISYS version 1.0 

Inclusive Dates 
Allows you to enter a date range between 
January 1, 1980 and December 31, 1994. 
The date range will included all illnesses 
that occurred during the time period 
specified. 
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Incidence/Prevalence 
You can choose one of five options 

Incidence -1" Hospitalization 
EPISYS only counts the lsl hospitalization for a particular NHRC or 
ICD-9 illness code during the defined time period (as specified in the 
INCLUSIVE DATES dialog box). For example, an individual over the 
course of his or her Navy career could be hospitalized more than once 
for the same diagnosis, however, with this option selected, they would 
only be counted once. 

Incidence - P Hospitalization/patient deaths 
Same as "Incidence - 1st Hospitalization" with deaths included in the 
count. 

Prevalence-All Hospitalizations 
Counts all hospitalizations for a particular NHRC or ICD-9 illness code 
during the defined time period (as specified in the INCLUSIVE DATES 
dialog box). Multiple hospitalization for the same individual and for the 
same illness code will all be counted. 

Prevalence-All Hospitalizations/patient deaths 
Same as "Prevalence - All Hospitalizations" with deaths included in the 
count. 

Inpatient deaths only 
Counts deaths occurring due to the illness code(s) selected. 

Opening an Existing Definition 

Before you start selecting variables for analysis you will need to open an existing file or create a new file. 

O    Choose Define Database Structure from 
the Database menu. 

JATABASE - DEFINITION 

Select a Definition Option 
Press SELECT to Complete Option 

SAVE then pre«* OK/CAIICEL 

Database Definition Option» 

♦   HHRC/ia»CMegories 

> Sex Categories 

> Dace Categories 

^ AgeCIssses 

> Service Branches 

"  Pay Grades 

> Occupation Rates 

> DutyPtatforms 

> Ocean Regions 

;  Inclusive Ostes 

> kick                        B 

> Descriptive Label 

■:■$&&■< 

iSBBX I: 

SS&VEÄS? 

%m 

X Cancel: 

Figure 3.2 DATABASE-DEFINITION dialog box. 
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©    Choose the OPEN push button. 

©    Select a filename by pointing to the 
name and clicking with your left mouse 
button. 

@   Choose the OK push button or press the 
Enter key. 

OPEN DEFINITION 

List of Existing Definitions:    list of already 

Select one 
Then click OK. 

rreated Oles 

• m 

Cancel 

Figure 3.3 OPEN DEFINITION dialog box. 

Creating a New Definition 

©    Choose Define Database Structure from 
the database menu. 

©    Choose the NEW push button. 

©    Type in a filename and choose the OK 
push button or press the Enter key. 

(SAVE DEFINITION AS El " -    : "5 
1           EmerllaiTmnfhp!fm»irtrifnR»ti#>           1 

t 

I                     1 i; 
1 

: v^iL^iiT'"■■"'-'"" S:,::-£ 

(^OK j^ancef I 
-   -   ~,   __ „„ _     „_ „ _   .   .  l 
Figure 3.4 SAVE DEFINITION AS dialog box. 

^*S»«g9^#^^ 

9{pte: EPYSIS will only accept eight characters for file names and automatically adds an EBC 
extension (EPISYS (Data)Base Control) to your eight character file name. EPYSIS will 
not allow you to add ah extension to your file name.     ' 

See page 31 to save a new or modified definition. 

Selecting Variable Options From the DATABASE-DEFINITION Dialog 
Box 

The DATABASE- DEFINITION dialog box contains a list of 11 variables with corresponding option buttons 
on the left-hand side and command buttons on the right-hand side. The last option on the dialog box, 
"Descriptive Label" allows you to type a descriptive title into a text editing box, which will appear on all 
your statistical output. 

When you change the options to the variables on the DATABASE-DEFINITION dialog box, you are 
changing the default values, which is; select major illness codes and all other variables separately. If you 
want to look at a sub-population, you will need to change the default settings. For example, if you only 
want to analyze viral diseases, broken down by males and females you will need to select major disease 
category "viral diseases" and change all the default settings to combined except the variable sex, which 
should stay at the default setting, "male and females separately." 
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Selecting NHRC/ICD9 Categories 

You can select a particular illness or group of illnesses using NHRC or ICD-9 codes. You also have the 
option of selecting illnesses by their major or minor illness grouping (See Appendix A, Major and Minor 
illness codes). Use the International Classification of Diseases, Injuries, and Causes of Death, 9th Revision, 
Clinical Modification (ICD-9-CM)2 and Appendix A as a references for making the following selections. 

©    Choose Define Database Structure 
from the Database menu. 

©    At the DATABASE-DEFINITION 
dialog box click on the 
"NHRC/ICD9 Categories." option 
button. 

©    Choose the SELECT push button 

DATABASE - DEFINITION 

Select * Definition Option 
Press SEIJECTto Complete Option 

SAVE then press OKJCAHCEL 

Database Definition Options 

•   MHRC JICD9 Categories 

> Sex Categories 

> Race Categories 

/ Age Classes 

> Service Branches 

> Pay Grades 

> Occupation Rates 

■ii        lla 

11 NEW 

OPE« 

SAVE 

5p 
SAVEAS 

SKS 

SELECT1 

Figure 3.5 DATABASE-DEFINITION dialog box. 

@    Point to one of the six options and 
click. 

1 DEFINE DATABASE - NHRC / ICD9 CODES ■Bel 

Solectone oftfie Type* Below ' 

PreaeaafCT rot tncMOial Selection«   - SEl£CT ■K-M 

■   .jv;ft:äHWW>lCI»'Co<le.jr»e«"i::: ,:;;;,: 
„■,...[■■,. 

dose •4   AlM*^<MogormSepreley ,Ch 

> AlMinorCetBoottoeSeparately 'OK   V V* 
> Select 1                                         ; . 

N Select hdMduatNHRCCodes 

'- SetectlndhWu«! raw Code»          

Chnosp 

SELEC: 
'^Cencd 

::/-i 

Figure 3.6 NHRC/ICD9 codes dialog box. 

The following steps will differ depending on the which one of the six options you choose. 

Major or Minor Categories Separately 

©    Choose the OK push button to accept your selection. 

Individual Major or Minor Categories 

©    Choose the SELECT push button. 

The Major or Minor dialog box will appear displaying a list of the categories, you may select one or more 
of the categories: 

"♦   Major and Minor categories are in ascending order by their numeric code. See 
Appendix A, Major Illness Categories Sorted Numerically by Major Illness Code for 
a list as it appears in the Major and Minor Categories dialog box. 
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S^Ott:     When you first enter the DEFINE DATABASE-MAJOR OR MINOR CATEGORIES dialog box 

all categories will be selected. To deselect click anywhere inside the list box. 
:'     y-,   j^.i  -f^.   ■■■      ■    ■ ■>•...,.      J 

©    Click the UP or DOWN scroll arrows 
until the Major or Minor category you 
want appears or move the scroll bar 
by clicking and dragging the bar in the 
direction you want to go. 

O    Click the item. 

©    If you want to select more than one 
item from the list, press and hold 
down the Ctrl key. With the Ctrl key 
held down click on each item you 
want selected. 

DEFINE DATABASE - MAJOR CATEGORIES 

Individual Major Categories: 

Choose One or More Tip Arrow 

Worm Caused Diseases 
Uncertain Etiology 
Neoplasms 
EfUtocrineMutrttkHi/Metabolic Diseases 
Diseases of Blood/Blood-Forming Organs 
Mental Disorders 
Diseases of Herootre SysterrtSense Orgal : 
Diseases of Circulatory System, 
Diseases of Respiratory System 
Diseases of Digestive System 
Diseases of Genitourinary System 

:nadbirtlt 
Diseases of SkinSSubcutaneous Tissue 
Diseases of Muscoli 
Congenital AnamoBes 
Perinatal MorbidHyMortaJity 
Symptom!                     Conditions 
Accident/Poisoning/Violence                   ~ 
Supplementary/Special Conditions < 

M 

ScrollBar 

tCaricel 

Down Arruw 

Figure 3.7 MAJOR CATEGORIES dialog box. 
If you want to select a sequential list of 
items hold down the left mouse button and 
drag across the block of items. You may also 
select the first item by clicking the left 
mouse button. Scroll through your list, 
using the arrows on the side until you find 
your last selection. Hold down the Shift key 
while clicking the left mouse button. This 
will paint a block that starts at your first item 
and ends at your last item. 

You may also deselect a selected item by 
holding down the Ctrl button and clicking 
each item you want deselected with your left 
mouse button. 

©    Choose the OK push button or press 
the Enter key. 

DEFINE DATABASE - MINOR CATEGORIES 

IndivkJud Minor Categoric?.: 

;'■:-;Ct»p^0rw:-örMor«:-:':f'. 

» Other/Unspec 
11 - intestinal ParasMsmUnsnec: 
12 - Swcoktoct* 
13-HeopJ»sm 
14 • Metabotic 
iS^BioodBtood^TOTning Organs 
16-Mental Meorder 
17 - n«e.;^aflo»,<- 
18-Circulatory System 
19 - Respiratory System 
20 - Digestive System 
21 - Genitourinary System 
22. Presnant^rOiHdbirth 
23 - Skln&ut» 
24- Muscokwfcefetal System 
25-CnnacnitalAninory 
26 - Perinatal MorbicBtyjMortaBty -': 
27 - SymptoinatfcaiMtefinetf 
2» - AcchtertypoJ«oninflA/ioterrce 
23.ySop!pfernetit«y^>ecfa>rtz-   ^•'■ 

m 

B 
I 3jl"Ärr<)W:.: 

m 

t?z 

& 
ScrollBar 

i_i; DownlArroW 

Figure 3.8 MINOR CATEGORIES dialog box. 

This will return you to the DEFINE DATABASE-NHRC/1CD9 CODES dialog box. 

©    Choose the OK push button or press the Enter key. 
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Individual NHRC Codes or ICD9 Codes Option 

©    Choose the SELECT push button. 

©    Type one code or a range of codes in each 
text editing box. Follow the examples t 
displayed on the top right-hand corner of the r. 
dialog box. If you do not know the codes 
follow the directions for looking up -\ 
individual NHRC and ICD-9 codes in the 
section titled, "Looking up Individual f 
NHRC and ICD-9 Codes," on page 20 or 
refer to Appendix B, NHRC illness codes. 

Codes entered in the text editing box must be a 
complete 5-digit code or a 3-digit sub-code 
followed by an asterisk. For example, 27027 or 270* 

DEFINE DATABASE -NHRC/ ICD9 CODES 

>'$MÜ1W$«tK 

-.ill        1 f        1 
^1                 U                 K 
i-..i          m          1 
■*l             U             M 

■]                   l,i                   te 
.4              W              II 

1        y        1* 
-.n            m            IP- 
it          (si          to. 

I             1!            1 

NHRC 1KB} Code famnple« 

Stogie Cod«   1ZHS 

RangixifCodee:   12J4S12K8 

»•Digit Code«;   123» 

COOES 

.(/« 

:|£cM!cef 

Figure 3.9 NHRC/ICD9 CODES dialog box. 

'      ••• l .     ■       - : 

CaUCIOnS   If you enter a three digit code with asterisk and you set the Incidence/Prevalence 
option to "Incidence-!s' Hospitalizations only" EPISYS will extract all'first time 
hospitalizations for the first three digits of a particular five digit series, but will 
exclude the cases that had multiple hospitalizations for different illness codes 
within that series. For example, Affective Psychosis has the NHRC series codes 
from 27001 to 27049. An individual could be hospitalized for Depressive Psychosis 
- Mild (27027) than again in later for Manic disorder Moderate (27016). By 
selecting the three digit code, that individual will only be counted once. 

y^^W^^^^^i^q^W^^'. 

•^^«j^sa^s^^t^^^i^^^ 

9{pte:     A three digit code followed by an asterisk will include all codes beginning with the three 
digits. '  ' .    ■ 

^Sm^^^^^^^i^^S^S, 

■■ ' .    •        ■■      ■  

Caution: NHRC and ICD-9 codes are not continuous which means the numbering system 
contains gaps. When entering a range of codes the first and last code entered in the 
text editing box must exist. Codes in between the specified range do not have to 
exist. EPISYS can only analyze 130 codes or less. If you enter more than 130 
codes a warning will appear.  _^^^_ 

^*^^*    •-    -""^""T^T .    -.    l^r*T™TT""T ...      . . .'   ",""—; ^^^^^ft^^^^mm^i 

Syote:     If you type an inappropriate code or a text string that does not appear in the database a 
 warning message will appear.  

■^^»^ygjjig*^?^^^!^'^^ 
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Looking up Individual NHRC and ICD-9 Codes 

There are four code search options available from the DATABASE-CODE SEARCH dialog box. 

1. Search for the equivalent NHRC or ICD-9 code(s) (page 21). 
2. Search for a string of text (page 22). 
3. Browse the NHRC and/or ICD-9 code database (page 23). 

For example, if you know the NHRC code but want the equivalent ICD-9 code you can search by NHRC 
and EPISYS will enter the equivalent ICD-9 code in the appropriate box and vice versa. If you do not 
know the code, you can type a text string in the "Text Search String" text editing box and EPISYS will 
display in a Windows editor all the NHRC and ICD-9 codes containing the word or word part you typed in 
the text editing box; or you can browse the NHRC and ICD-9 illness code database. 

Caution: 
•■ -:-        ■-    * — *—         ■       ■ '      ■,   ■ .-       ; «■■»^j^tei^^^^^S 

Illnesses code descriptions are abridged so that they can fit on the screen. For 

example, illnesses containing the word tuberculosis in the description could be 
abbreviate TB or Tuber or tuberculosis. If you want to see all illnesses containing 
tuberculosis you will need to refer to the ICD-9 reference or browse the NHRC and 
ICD-9 illness code database. See the section titled, "Browsing the ICD-9 and 
NHRC Illness Code Database," on page 23. 

Searching NHRC or ICD-9 Codes 

To find the equivalent NHRC or ICD-9 illness code and description follow the directions below: 

O    Choose the CODES push button from the DEFINE DATABASE-NHRC/ICD9 CODES dialog box. 

©    Click inside the NHRC 
Code or ICD9 Code text 
box and type a code. 

©    Choose the corresponding 
FIND push button. 

DEFWE DATABASE - NHRC IICD9 CODES 

Entet HMRC ot KM Code» HHRC / KB» Code Example* 

SngteCooe:    12345 

Range ofCodes:    12348.17350 

WKgK Code.:   123* 

|^0K 

Figure 3.10 NHRC/ICD9 CODES dialog box. 

DATABASE   CODE SEARCH 

F« in ite ApproprMe HeM 
then 

PrcMtfOB) for «pednc code 
Pres« KtOWSE for «K code* 

Pros« OK when done 

NWtC or 1C09 Coö» RMMf be 
• «omptet» S-olgtt code 

■-   or«3-cSoHt«tf«roQowodt>y«n 
ester §*k 

CodeSetfch is not Ca*e SenstWm 

The Text Search Suing mty be 
1 - 24 cnerecter» lono. 

end 
ffwy be e Mbttt ofthe 

Text Description 

TextSearcnSUIno 

Text Seven fa» net Ce*Mt5enMH*e 

Figure 3.11 CODE SEARCH dialog box. 
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->   EPISYS will display the equivalent ICD-9 or NHRC code in the corresponding text 
box and the illness description in the "text search string" text box. 

©    Choose the OK push button. 

9^0te:     If you only need to enter one code into the DEFINE DATABASE - NHRC/ICD-9 CODES 
dialog box you can highlight the code, choose Copy from the Edit menu, Exit WnBrowse® 
and paste the code into the text editing box. If you need to enter more than one code you 
will need to write down the information or remember the information provided. 

&&%%<»«*gg^ 

This will return you to the previous dialog box. 

©   Enter the code in the text editing box. If you do not know how to enter codes follow the direction in 
the section titled, "Individual NHRC and ICD-9 codes option," on page 20. 

Searching a String of Text 

You may want to find the NHRC or ICD-9 code for a particular illness or a range of NHRC or ICD-9 
codes. You can type a string of text in the text editing box and choose the ICD9 or NHRC push button to 
search the illness database for all occurrences of the string. To search for a string of text follow the 
directions below: 

O    Choose the CODES push button from the DEFINE DATABASE-NHRC/ICD9 CODES dialog box. 

©    Click inside the "Text Search String," 
text editing box. Type a text string or a 
range of codes (for example 270*-280* 
or Viral). EPISYS will only accept 24 
characters in the "Text Search String" 
text editing box. 

©    Choose the NHRC or ICD9 push button. 

Your search results will appear in 
WnBrowse, a Windows editor. 

The following numeric annotations refer to 
Figure 3.13. 

If you push the NHRC push button, NHRC 
codes will appear in the first column. 
However, if you push the ICD9 push button 
ICD-9 codes will appear in the first column. 

O This is the Illness code table searched 
by EPISYS (either NHRC or ICD-9). 
In this example ICD-9 was chosen by 
selecting the ICD9 push button from 

DATABASE - CODE SEARCH 

F8I in the Appropriate Field 
then 

Press FMD for «pecffic code 
Press BROWSE for «II codes 

Press OK when done 

NHRC or ICB9 Code must be 
a complete 5-digit code 

or a Xdlgtt code followed by an 
asterisk 

Code Search te not Case Sensitive 

TrmTe^SewchSbtoQinaybe 
1-24 characters lono 

and 
may be a subset of the 

Text Description 

Test Search is not Case SenjtWws::\\ 

Test Search String 

t/0*! 

Figure 3.12 Code Search dialog box. 
L« WBBrowse-ebsrch.tmp 

£8o   ftitt   Search   jftev   Options   Help  

SEARCH RESULTS 

0 Code Type        :    ICD9-CM   

© Search String:    VIRAL   

ICD9      HHRC      Text Description 

ILLMESS  CLASSiriCATION   SYSTEM 
TEXT STRING 

00860 

00880 
04200 
04210 
04220 
04290 

04300 
04310 
04320 
04330 
04390 
04400 

04760 

04790 
04910 
04980 
04990 
05780 
OS790 

00905 

00906 
06930 

06931 
06932 

06933 
06934 
06935 

06936 
06937 

06938 
06939 
04104 

04103 
06912 
05706 
05707 

05006 
05004 

VIRAL ENTERITIS NEC 

VIRAL ENTERITIS N0S 
OTHER VIRAL 
OTHER VIRAL 
OTHER VIRAL 
OTHER VIRAL S 

OTHER VIRAL y^ 
OTHER VIRAL        S 
OTHER VIRAL 

OTHER VIRAL 
OTHER VIRAL 
OTHER VIRAL 

VIRAL HEHIHGITIS NEC 
VIRAL HENINGITIS N0S 
ADEN0VIRAL MENINGITIS 
VIRAL ENCEPHALITIS NEC 

VIRAL ENCEPHALITIS N0S 
VIRAL EXAITTHEHATA NEC 

VIRAL EXANTHEMATA N0S 

Ai_t_ OCCURAHCCS or THE TEXT 

STRING  AMD  THE IP  ASSOCIATED 
I CD-S3  AND   NHRC  CODES. 

Figure 3.13 WnBrowse search results. 
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the Code Search dialog box. The first column displays ICD-9 codes. If the NHRC push button was 
selected, the first column would display NHRC codes. 

©    The search string typed in the Text Search String editing box. 

©    The code table you choose to search on (ICD-9 or NHRC) and a list of codes which contain the 
occurrences of the text string searched on. 

0    The equivalent illness code from the other (NHRC or ICD-9) coding system. 

©    The abbreviated illness title which refers to both columns of codes. 

f%te;;y'. -Tfiere are more NHRC codes than there are ICD-9 codes. If you see a slash ~ mark in the 

ICD-9 column that means there is no equivalent ICD-9 code for that particular NHRC 
illness code.   .'.'■.'"'' 

Pi&**m^iwa^^ ?M^^kkS'$m$!!>& 

Browsing the ICD-9 and NHRC Illness Code Database 

You can view all the NHRC and ICD-9 codes by pushing the BROWSE push button. If you choose the 
BROWSE push button to the right of the NHRC codes text box the database will be sorted numerically by 
NHRC codes. 

9{pte:     If you select the BROWSE push button to the right of the ICD-9 codes text box the 
database will sort numerically by ICD-9 codes. The first column of codes will always be 
NHRC codes and the second column of codes will always be ICD-9 codes. 

See Chapter 5, "Using WnBrowse, " to learn how to use WnBrowse's edit and print features. 

Exiting the WnBrowse screen 

O    Choose Exit from the File menu. 

Printing NHRC/ICD-9 Code Search Results 

O    Choose Print from the Fil e menu. 

The Print Options dialog box will appear with the defaults appropriately set. To learn how to change the 
options read Chapter 5, Using WnBrowse. 

©    Choose the OK push button or press the Enter key. 
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"♦   Choosing Exit from the File menu will return you to the previous screen. Read the 
directions in the section titled, "Individual NHRC or ICD-9 codes option," on page 
20, to learn how to type codes in the text editing box. 

Selecting Sex Categories 

You can either choose to look at males and females separately, combined, males only or females only. 

O    At the DATABASE-DEFINITION dialog 
box click on the "Sex Categories" option 
button. 

©    Choose the SELECT push button. 

[DATABASE - DEFINITION ■ x| 

Select a Definition Option 
Press SELECT to Complete Option NEW 

SAVE then press OKJCANCEL 

V' 'v:\~M\ik\ ■™ÄÄ^is^;S=■:■^■'.:;>=i', ■ ■:-■ -.^:■ ^r.r.-'F<J.             r~tL::.-:J]J 

' OPEN 

Database Definition Options 

NHRC/ICW Categories 

•   Sex Categories 

'- Rate Categories 

,**  Age Classes 

,> Service Branches 

> Pay Grades 

SAVE 

SAVEAS 

SELECT 

Figure 3.14 DATABASE-DEFINITION dialog box. 

©    Click one of the four options buttons. 

@ Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"Males and Females separately." 

Selecting Race Categories 

JDERNE DATABASE-SEXCATEGORY                 E 

Choose One Category 

Press OK or CANCEL • « 
SeX*eie^OrieS:s:f.:::''V''>::-^y::ii!!k 

• •   Male and Female Separately 

> Male Only 

> Female Only 

P Male and Female Combined 

^Cancel 

Figure 3.15 SEX CATEGORY dialog box. 

DATABASE - DEFINITION 

You can either choose to look at all race categories combined or select an individual race category. 

©    Choose Define Database Structure 
from the Database menu. 

©    At the DATABASE-DEFINITION 
dialog box click on the "Race 
Categories," option button. 

©    Choose the SELECT push button. 

Select a Definifian Option 
Press SELECT to Complete Option             1 NEW 

SAVE then press OK/CAHCEL                 i 
OPEN 

Database Definition Options                 i 

> NHRC nC09 Specification                    j 

> UHRCJIC03 Categories 

> Sex Categories                                 i 

♦   Race Categories                               , 

-   Age Classes 

> Service Branches                             | 

- SAVE 

SAVEAS 

SELECT 

Figure 3.16 DATABASE-DEFINITION dialog box. 
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@    Click one of the three options 
buttons. 

© Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"All Race Categories Separately." 

IDEFINE DATABASE - RACE CATEGORIES ■"x : 

Sv:l:^iV^E:'^vy'\;:b^^ 
Select one of tne Categories Below 

Pie»» SELECT for kidwidual Sefccifem* 
SMCT 

Race Categories 

'    * , An Race Categories Separate^ ^OK 

N Select lndHii<kul Race Categories* 

(      > All Race Categories amokled )fa***l 

       . 
Figure 3.17 RACE CATEGORIES dialog box. 

"►   If you selected the "individual race categories" option button you will need to choose 
the SELECT option button instead of the OK option button. 

©    Click an item. If you want to select 
more then one item from the list hold 
down the Ctrl key while clicking the 
left mouse button to select the next 
item 

0    Choose the OK push button. 

This will return you to the previous dialog 
box. 

1 DEFINE DATABASE - INDIVIDUAL RACE CATEGORIES ^n 
Individual Race Categories 

Choose One or More ^OK 

Black =   :;S-S:s";:ä   m:ii:m";U: ^^Mit-M^ 
Other AJnspec 

Mbancel 

Figure 3.18 INDIVIDUAL RACE CATEGORIES dialog box. 

©    Choose the OK push button. 

Selecting Age Classes 

You can either choose from a list of preset age classes (See list of age classes below) or define your own 
age classes. The default age classes were based on the Surveillance, Epidemiology, and End Results3 and 
were developed because of the high number of 17-24 year old enlisted in the Navy. 

17-19 30-35 
20-21 36-39 
22-24 40-44 
25-29 45-61 

O    Choose Define Database Structure 
from the Database menu. 

©    At the DATABASE-DEFINITION dialog 
box click on the "Age Classes" option 
button. 

©    Choose the SELECT push button. 

IDATABASE - DEFINITION ■Tx 
1 

Select a Definition Option 
Press SELECT to Complete Option             [ tew 

SAVEthen press OKJCANCa 
OPEN 

Database Definition Options 

> HHRC/(CDS Categories                       | 
SAVE 

/ Sex Categories 

^ Race Categories 
.SAVEAS 

♦   Age Classes                                       I 

> Service Branches                           , 
. SELECT   j 

'■ 

Figure 3.19 DATABASE-DEFINITION dialog box. 
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0    Click one of the three options buttons. 

© Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"Standard Age Classes Separately." 

[DEFINE DATABASE - AGE CLASSES Bx -    .                                 ... 
Select one ofthe Categories Below              1 

• saKT 

Age a*ss Categor (ee                           1 

4 'Standard AoeOaMNWSeperijey ^»OK 

.      > Selected Age Ctacee* Separately 

^    -\ MAqeOwse»Combined                        1 }fCancel 

1 
Figure 3.20 AGE CLASSES dialog box. 

"♦   If you selected the "Selected Age Classes Separately" option button, you will need to 
choose the SELECT push button instead of the OK push button. The DEFINE 
DATABASE-NON STANDARD AGE CLASSES dialog box will appear: 

You will notice the eight default age classes are already entered in the text editing boxes. 

©    For each new age class click on the text 
editing box in the start column and 
highlight the default value. Hit the 
Delete key or type in a new value. 

Note: Ignore the stop values. EPISYS will 
replace each with the appropriate value. You 
can create up to 12 age classes. 

©    Once you have entered all the starting 
ages in the start column choose the 
SHOW push button. 

The SHOW push button will automatically 
enter the appropriate ending ages for each 
value in the stop column. 

S DEFINE DATABASE -NON-STANDARD AGE CLASSES                              0 

Wr': Enter Starting Age for Each Age Class 

1     Aoe Class I       I   Start I    StOD     I 

1 

2 

3 

illllH- P • h    t • 
I20 |*i         [K'iS'fiSsHä SHOW 

% ■■s|22 ■|f:-S|24         |;cf.:i'.-.i'. 

|S|::ö:^ ?>/'■'■ ;:^4:^X *? il25 ^M|29          j 

isT-.-'n: *•-.'.':. '::U:<8|30 ' I34        1 
!;;!••: ::-Y*^P. ■v j;J35 J39             | 

|/0K 
7 fs;s>;-;|4o Ki'l44        1 

wSS&k:&- J45 Sis]61       j 

s |           p$:«MZ 
10 I           I        •   • ^Cancel 

j           | iÖi'ivV".'«. ' V#V:L ::■?■*« 

iiimMmm •; |     | 

9ktM:M3Mr | 

11 
Figure 3.21 NON-STANDARD AGE CLASSES dialog box. 

CautlOnS   EPISYS uses the start value in the preceding start column to calculate the ending 

value in the proceeding stop column thus you must enter one more start value than 
needed for EPISYS to calculate the last ending value. EPISYS will delete the last 

 entered value in the start column when you choose the SHOW push button.  

®    Choose the OK push button to accept your entries. 

This will return you to the previous dialog box. 

©    Choose the OK push button. 
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Selecting Service Branches 

Only US Navy enlisted is currently available 

Selecting Pay Grades 

O    Choose Define Database Structure from the Database menu. 

©    At the DATABASE-DEFINITION dialog 
box click on the "Pay Grades," option 
button. 

©    Choose the SELECT push button 

© Click one of the three options buttons. 

© Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"All Grade Categories Separately." 

DATABASE - DEFINITION 

Select» Definition Option 
Press SELECT to Complete Option 

SAVE «ben press OK/CANCEL 

Database Definition Options 

/  HHRC/1C09 Specification 

;   NHRC/ICD9 Categories 

',   Sex Categories 

> Race Categories 

> Age Classes 

Serrice Branches 

•   Pay Grades 

:NB«> 

*OPENK 

SSAVEv 

SSAVEÄSJi 

saECtP 

Figure 3.22 DATABASE-DEFINITION dialog box. 

IDEF1NE DATABASE-GRADE CATEGORIES SI 
r -:| 

Sated one of the CMegorie» Below 

Pre»» SELECT for IndMdual Selection» 
- SEKT K \ 

Crode Ceteflorie»                             /' 1 

$   AaCradeCaleaone» Separately         / V* "i 
•:  Select Indivlflual Grade Categorie*' 

/ Alt Grade Cetegorie» Combined 1N<$ .:      j 
ii:*   I 

Figure 3.23 GRADE CATEGORIES dialog box. 

If you selected the "Individual Pay Grades" option button, you will need to choose 
the SELECT push button instead of the OK push button. 

©    Click an item. If you want to select 
more then one item from the list hold 
down the Ctrl key while clicking the 
left mouse button to select the next 
item. 

0    Choose the OK push button to accept 
your selections. 

This will return you to the previous dialog 
box. 

DEHNE DATABASE- INDIVIDUAL GRADE CATEGORIES 

Individual Grade Categories 

Choose One or More 

Enlisted-2 
Enlisted-3 
Enlisted-4 
Enjisted-5 
Enlisted-6 
Entisted-7 
Enlisted-8 
Enlisted-9 

OK' 

Cane* 

Figure 3.24 INDIVIDUAL GRADE CATEGORIES dialog box. 
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©    Choose the OK push button. 

Selecting Occupation Rates 

O   Choose Define Database Structure from the Database menu. 

©    At the DATABASE-DEFINITION dialog box 
click on the "Occupation Rate," option 
button. 

©    Choose the SELECT push button. 

■'-• Age Classes 

> Service Branches 

> Pay Grades 

4   Occupation Rates 

> Duty Platforms 

> Ocean Regions 

> Inclusive Dates 

y Incidence/Prevalence 

■ Descriptive Label 

SaECT 

W^ 

M1 

V'*. 
^Cancel 

0    Click one of the three options buttons. 

© Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"All Rate Categories Separately." 

Figure 3.25 DATABASE-DEFINITION dialog box. 

DEFINE DATABASE-RATE CATEGORIES 

Select one of the Categories Below 

Press SELECT for Individual Selections 

Rate Categories 

>   All Rate Categories Separately 

,) Select Individual Rate Categories1 

,   All Rate Categories Combined 

Figure 3.26 RATE CATEGORIES dialog box. 

"♦   If you selected the "individual rate categories" option button you will need to choose 
the SELECT push button instead of the OK push button. 

Wif&<ff*$»t&tw*mfr.#%&im>l^^ 

9\0te:     Occupation rates are sorted by their code and arranged in ascending order. Use Appendix 
C as a reference for selecting individual occupations. Appendix C lists occupation rates by 

 either rate code or occupation title.       .    ;.        - 
^äsawaäwwp^^^^ 

©    Click an item. If you want to select more then one item from the list hold down the Ctrl key while 
clicking the left mouse button to select the next item 

@    Choose the OK push button. 

This will return you the previous dialog box. 

©    Choose the OK push button. 
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Selecting Duty Platforms 

©    Choose Define Database Structure from the Database 

©    At the DATABASE-DEFINITION dialog box 
click on the "Duty Platforms" option button. 

©    Choose the SELECT push button. 

menu. 

.   Service Branches 

> Pay Grades 

> Occupation Rates 

♦   Duty Platforms 

i      •  Ocean Regions 

;     / Inclusive Dates 

I     > IncidenceJPreralence 

j     > Descriptive Label 

SELECT' 

I^OK 

ijp^ncei 

Figure 3.26 DATABASE-DEFINITION dialog box. 

©   Click one of the three options buttons. 

©    Choose the OK push button to accept 
your selection or the Cancel button if 
you want to keep the default settings, 
"All Platform Categories Separately." 

IDEFINE DATABASE - PLATFORM CATEGORIES Hl'x-f 
, 

Select one of the Categories Below 

Press SELECT for Individual Selections             1 
SELECT 

i£ ';■- -■:. 

Platform Categories                            / 

•*   AH Platform Categories Separately         /   ■ 

Select Individual Platform Categories '         ' 
1 

> AD Platform Categories Combined                 ] 

|^0K i 

Jfcanoeli 

u__ i.-.^'A-^-X'X":'': ''M'mSss:W3:s:: m-m:M 

Figure 3.27 PLATFORM CATEGORIES dialog box. 

"▼   If you selected the "individual platform categories" option button you will need to 
choose the SELECT push button instead of the OK option button. 

©    Click an item. If you want to 
select more then one item 
from the list hold down the 
Ctrl key while clicking the 
left mouse button to select the 
next item 

0    Choose the OK push button. 

This will return you the previous 
dialog box. 

IDEFINE DATABASE-INDIVIDUAL PLATFORM CATEGORIES! 

Individual Platform Categories 
■■■_:};;J; 

Choose One or More "|j^0K j 

Submarine '• vffi    * 

1 
Submarine Attack Nuclear 
Submarine Ballistic Missile Nuclear 
Hospital Ship 
Auxiliary/HonCornbatant 
Miscellaneous 
Other 
Ashore 
Unknown 

. 
i 

JfCancel; 
iv--:'-'! 
:r:;: ■;! 

./'.:;.*l:::-V ■ 

©    Choose the OK push button. Fi§ure 3'28 INDIV1DUAL PLATFORM CATEGORIES dialog box. 

Selecting Ocean Regions 

Only the default. "All Ocean Categories Combined," is currently available. 

Setting up the Analysis 29 



Selecting Inclusive Dates 

©    Choose Define Database Structure from the Database menu. 

©    At the DATABASE-DEFINITION dialog 
box click on the "Inclusive Dates," option 
button. 

©    Choose the SELECT push button. 

l    / Sen*» Branche» 

!    > Pay Grades 

(    > Occupation Rates 
I " I 

Duty Platform* 

Ocean Regions 

I   •''   Inclusive Dates 

> btcioenceJPreialeiice 

I     > Descriptive Label 

sSftECJg 

V( 

* Cancel 

Figure 3.29 DATABASE-DEFINITION dialog box. 

The Inclusive dates dialog box will appear with the default dates enter in the text box. You may enter dates 
which fall in this time range. A warning message will appear if you enter a date that does not fall in the 
default time period, January 01, 1980 to December 12, 1994. 

@    To change the beginning and ending dates click on the text box and highlight the default value. Hit 
the Delete key or type in the new date. Dates should be entered in the following format: DAY, 
MONTH, YEAR (DD-MM-YY). EPISYS will automatically insert separators between the day and 
month. 

©    Choose the OK push button to accept your entries or the Cancel button if you want to keep the 
default settings, "01-01-80 to 31-12-94." 

Selecting Incidence/Prevalence 

©    Choose Define Database Structure from the Database menu. 

©    At the DATABASE-DEFINITION dialog 
box click on the "Incidence/prevalence," 
option button. 

©    Choose the SELECT push button. 

> Service Branches 

> Pay Grades 

- Occupation Rates 

I'Mfctrr! d 

,     '> Duty Platforms 

> Ocean Regions 

/ Inclusive Oates 

4   IncidenceJPrevalertce 

/ Descriptive Label 

|/<* 

^Cancel 

i 

Figure 3.30 DATABASE-DEFINITION dialog box. 

©    Choose one of the five options. See page 
16 for Incidence/Prevalence definitions 
before making your selection. 

DEHNE DATABASE - INCIDENCE/PREVALENCE 

Choose One Type 
then 

PrewOKorCAHca. 

ktcideneeJPrevalence l>pe» 

• hKldeme-1tt^pft«tettfons 

> ImMene 
> Prmalen 

> Premtence - Ml Hoipit.liz.tion» rPatlent Deaths 

; Bip«tteiit Death* OMy 

©    Choose the OK push button to accept        Figure 3.31 INCIDENCE/PREVALENCE dialog box. 
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your selection or the Cancel button if you want to keep the default settings, "Incidence-Is' 
Hospitalizations." 

Adding a Descriptive Label to Statistical Output 

O    Choose Define Database Structure from the Database menu. 

©    At the DATABASE-DEFINITION 
dialog box click on the "Descriptive 
label," option button. 

©    Choose the SELECT push button. 

> Service Branches 

> Pay Grades 

•"> Occupation Rates 

> Duty Platforms 

> Ocean Regions 

> Inclusive Dates 

> rncktenceJPrevalence 

<£■ . Descriptive Label. 

I'SEtEGT* 

iSI 
m 

Kancd 

Figure 3.32 DATABASE-DEFINITION dialog box. 

@    Type up to 50 characters in the text 
editing box. The text will appear on all your statistical output for this particular definition. 

©    Choose the OK push button to accept your entry. 

Saving Definitions 

The DATABASE-DEFINITION dialog box contains two commands for saving. Save and Save As. You use 
the Save command to save changes to an existing definition. You use the Save As command to name and 
save a new definition or to save an existing definition under a new name. For example, you may want to 
make changes to a definition, yet also keep the original definition without the changes. By using the Save 
As command, you can save a copy of the original file with a different name. 

Save As 

O    From the DATABASE- 
DEFINITION dialog box after 
you have opened a new file. 
Choose the SAVEAS push 
button. 

(DATABASE- DEFINITION                                               -:JH| 

Select a Definition Option 
Press SELECT to Complete Option 

V 

SAVE then press OK/CANCEL 
OPEN A:: 

>                   Definition Options 

<*   HHRC/ICD9 Categories 

> Sex Categories 

> Race Categories 

> Age Classes 

■   Service Branches 

} Pay Grades 

/ Occupation Rates 

.   SAVE 

JSAVEASv 

Ipalclff; 

Figure 3.33 DATABASE-DEFINITION dialog box. 
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©   Type an eight-character file 
name in the text editing box. 

SAVE DEHNmON AS 

>B»tpr Haroe Of PefmHion to S»»e 

•(^OK ^Cancel 'iiM^iir:^^^! 

* 
Figure 3.34 SAVE DEFINITION AS dialog box. 

9{gtt: EPYSIS will only accept eight Characters for file names and automatically adds an EBC 
extension (EPISYS (Data)Base Control) to your eight character file name. EPISYS does 
not allow you to type an extension for your eight character file name. 

mimtx^m^MMmi» -^iy^a»^^^t51i^»^t^^^i^»i&*SSsSJ^iavV>^i^*^»i^fc^i^^ 

©    Choose the OK push button. 

Save 

O    Choose the SAVE push button from the DATABASE-DEFINITION dialog box. 

9{pte:     A warning will appear if you did not save your definition before exiting the DATABASE 
DEFINITION dialog box. Choose the NO push button to return to the DATABASE 
DEFINITION dialog box and save your definition before exiting. 

^■^#$*P&^^«»^.^^'SJj»j? 

Deleting a Definition 

O    Choose Delete Episys Analysis from the EpiSys menu. 

©    Select a filename by pointing to the 
name and clicking with your left 
mouse button. 

©    Choose the DELETE push button. 

A warning box will appear. 

DELETE DEFINITIONS 

List of Existing Analyses: 

Select one 
Then click DELETE. 

mutti.ebc 
neoplasm.ebc 
new.ebc 
tubercu.ebc 
viral.ebc 

ÖELETEi 

JtCancel 

Figure 3.35 DELETE DEFINITIONS dialog box. 
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0 Choose the Yes push button to delete 
the analysis or the No push button to 
abort the action. 

IDELETE DEFINITION                                    ÖI 

£^     This Option Deletes Definition - 
*H          new 

||H           Do You Wish to Continue? 

" 

I^Yes 0* 
Figure 3.36 DELETE DEFINITION warning box. 

This will return you to the DELETE DEFINITIONS dialog box. Choose the Cancel push button when you 
are finished deleting definitions. 
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Viewing the Results 
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Database Extraction 

Before you can view your results and after you have defined the database (See Chapter 3, Setting up 
the Analysis) you need to perform a database extraction. A database extraction will extract the 
variables meeting the incidence/prevalence criteria and occurring within the inclusive dates selected 
by you from the DATABASE-DEFINITION dialog box. If the dates and incidence/prevalence option 
were not modified then the default dates (January 1, 1980 to December 31, 1994) and incidence 
option (Incidence - lsl Hospitalizations only) is used. 

O    Choose Perform Database Extraction from the 
Database menu. 

©    Select a filename by pointing to the name and 
clicking with your left mouse button. 

A warning will appear if you have previously 
performed a database extraction on the filename 
selected. Choose Yes to continue, No to abort. 

©    Choose the OK push button. 

DATABASE - EXTRACTION EÜ 
List of Existing Definitions 

Select One 
 Ihui  

.-'■ Click OK to Continue |^0K 

multi.ebc 

•   ' 

*:;];-;;^;:J;^'Jvi-;;.VÜ 

new.ebc 
viratebc 

||Cancel 

:0^ 

Figure 4.1 Database Extraction dialog box. 

It will take several minutes to extract the database. A dialog box will appear with a status bar and the 
percent of extraction completed. Wait until the dialog box disappears before attempting to review the 
database extraction. 

Reviewing Database Extraction 

Before you perform a multi-variate or univariate analysis, you should review your data to verify your 
selections. 

©    Choose Review Database Extraction from the Database menu. 

© 

© 

0 

Select a filename by pointing to the name and 
clicking with your left mouse button. If the 
filename you want does not appear you will 
need to perform a database extraction, see the 
previous section titled, "Database Extraction." 

Select an analysis option; Text Report, 
Spectral Density Analysis or Time series 
Analysis by pointing to the option button and 
clicking with your left mouse button. See 
explanation of options starting on page 36. 

DATABASE EXTRACTION - OUTPUT 

Available Extractions 
ChooseOne 

Choose Analysis Option 
Press Pl.01 
. Press OK when Done 

^Analysis Options ■{ 

<♦ ! Text Report' 

/ Spectral Density Analysis 

> Time Series Analysis 

PLOT ■ VPfÄB; 

• * 

Figure 4.2 Database Extraction Output dialog box. 

Choose the PLOT push button if you want to 
view the results in color and choose the PRINT push button if you want to view your results in 
black and white. 
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9{pte:    There is no difference between the PLOT and PRINT push button if you choose the Text 
Report option. 

If you select Spectral Density you will be asked to enter start and stop limit values. The 

start value can be two or higher and the stop value can be any value. You should only be 
concerned with the stop value if you do not see the line flatten out, which means you have 
not observed all the peaks in your data set. You should change the stop value to a higher 
value until you see the tail flatten. 

>.     -..■»■   . ■- ..   ...,.|t r^.i.".  ■■■i>'-i<,tV!<  fw.*-   .'-•; 

The results will display in a Windows editor. 

©    To return to the DATABASE EXTRACTION-OUTPUT dialog box choose Exit from the File menu 
when viewing the Text Report option and the Done menu when viewing the Spectral Density 
and Time Series Analysis. If you would like to print, read the sections titled, "Printing Text 
Reports," on page 37 and "Printing Spectral Density and Time Series," on page 39. 

© When you are finished viewing the extraction options, choose the OK push button. 

Extraction Options 

There are three extraction options, Text Report, Spectral Density Analysis and Time Series Analysis. 
The information displayed in all three extraction options is specific to the inclusive dates selected by 
you in the DEFINE DATABASE - INCLUSIVE DATES dialog box and the incidence/prevalence option 
selected by you in the DEFINE DATABASE - INCIDENCE/PREVALENCE dialog box. If the dates and 
incidence/prevalence option were not modified then the default dates (January 1, 1980 to December 
31, 1994) and incidence option (Incidence - P'Hospitalizations only) will be used. Only the cases 
which meet the incidence/prevalence criteria and occurred during the time period are counted. 

SWnBrowse-jnulti.ebr 

Text Report 

All text reports list the 
variables and their 
breakdowns with the number 
of cases and total number 
per person-years expressed 
in scientific notation. 

The following numeric 
annotations refer to Figure 
4.3 

© Incidence/Prevalence: 
the Incidence/Prevalence 
option is selected by you in 
the DEFINE DATABASE - 
INCIDENCE/ PREVALENCE 
dialog box. If the option was 

£dit    Search    View    Options    Help   

TTil[^1f^iaMgAi|^TYT¥!^lK 
DATA EXTRACTION REPORT 

(T) Incidence - First Hospitalizations Only 

Q) Number of Records:  1147015 
Q) 0 Number of Cases :   692341      ^ 

DIAGNOSTIC CODE - Major Categories (All) 

Viral Diseases 
Bacterial Diseases 
Mycobacterial Diseases 
Rickettsial Diseases 
Chlamydial Diseases 
Sexually Transmitted Diseases 
Fungus Diseases 
Spirochete Caused Diseases 
Protosoal Diseases 
Ectoparasites 
ttorm Caused Diseases 
Uncertain Etiology 
Neoplasms 
Endocrine/Nutcition/Hetabolic Diseases 

Cases */Per-Year 

29606 3.9961e-03 
6804 9.1838e-04 
421 5.682Se-0S 
44 5.9390e-06 
4 5.3990e-07 

2666 3.5985e-04 
2713 3.6619e-04 
226 3.0S05e-05 
390 5.2641e-05 
276 3.7253e-0S 
140 1.8897e-0S 
465 6.2764e-0S 

13000 1.7547e-03 
9535 1.2870e-03 

ALL 
''Op^J^tBntOisp^liifdnnagotooyExit 

•ma 

.jt 
Figure 4.3 Text Report output. 
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not modified, the default option (Incidence-lsl hospitalizations only) is used. In Figure 4.3 
"Incidence-1st hospitalizations only" was selected, therefore case counts will only include the first 
hospitalization for a particular NHRC or ICD-9 illness code (See page 16 for a list of 
Incidence/Prevalence options and their definitions) 

© Variable Breakdowns: a list of the variables and their breakdowns selected by you in the database 
definition dialog box. 

© Number of Records: a count of all the records currently in the database during the defined time 
period (includes multiple hospitalizations). 

© Number of Cases: a count of all occurrences meeting the Incidence/Prevalence criteria. In Figure 
4.3 case counts are only those cases which meet the Incidence-lsl hospitalization only criteria. You 
will notice the number of cases is lower than the number of records. The counts differ because 
Number of Cases dose not include multiple hospitalizations for the same illness. If you choose 
Prevalence (counts all cases including multiple hospitalizations) then number of records and cases 
should be equal when the category All Major Categories is selected. 

© Cases: a count of all cases meeting the Incidence/Prevalence criteria. In Figure 4.3 the counts 
would only include first hospitalization for a given illness. 

© #/Per-year: 
The number of cases per person-year for a particular illness. 

The number of cases divided by the entire EPISYS population denominator file (= 7.4 million). The 
entire population file counts an individual for each year of service within the inclusive dates. For 
example, if a person worked four years they would contribute four person-years to the total person 
years at risk 
In Figure 4.3 Viral Diseases would be calculated as follows: 

(29606) / (= 7.4 million) = 

.0039961 or3.9961e-03 

WjjM^ii^ 

If you received unexpected results and/or variable breakdowns try redefining the definition 
from the DATABASE DEFINITION dialog box again, see Chapter 3, Setting up your 
Analysis. ___^_^ 

:^..........    ..«..r..^ .». -—.. w. —•r.,,^MFW»«»..-..« ,...,.. -^..-..,.-»   ......      .     .   .. ::"'.*.*   .   .      . .. j 

Printing the Text Report 

When viewing the Text Report on the screen ... 

©     Choose Print from the File menu. 

The Print Options dialog box will appear with the defaults appropriately set. To learn how to change 
the default options, read Chapter 5, Using WnBrowse. 

Choose the OK push button. 
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Spectral Density Analysis 

Shows the sampling cycle of your 
data. For example, in Figure 4.4 the 
data peaks on the 7lh day. The data, 
therefore, has a prominent seven day 
cycle. To sample this data correctly 
you must select a time period no less 
than seven days. 

Power Spectral Density; 

0000 

(1 

A \ 

A \ i 
/ \J 

i 

2.O0OO0   3.00000   4.00000   S.00000   6.00000    7.00000   8.00000   9.0000010.0000011.0000012.C 

ERSYS-PRNT 
Print    Done 

O  Outside Local ^      . JitneSeriesr*per 10000Person=Years>- „ 
Outside Global i ;    Outside Bo 

Figure 4.4 Spectral Density Extraction Output. 

Time Series Analysis. 

Shows the annual and historical 
trend of your data. The green 
shading (light gray) is the annual 
illness trend. The annual trend is 
calculated using a three-year 
moving average. The brown 
shading (dark gray) is the 
historical illness trend which 
takes in to account all the years of 
data selected by you in the 
DATABASE-DEFINITION dialog 
box. The default is January l, 
1980 to December 31, 1994. The 
black line represents the data 
points in your data set. The 
legend displayed on top, Local, 
Global or Both are indicators of 
data which falls outside the 
annual or historical trends. F,§ure 45 Time Series faction Output. 
"Both" is an indication that your data falls outside historical and annual trends. An "epidemic" occurs 
when data falls outside the historical and annual trends. The numbers on the Y axis are rates per 
person-years. You can select the number of person-years at risk in the DATABASE-GLOBAL 
DEFINITIONS dialog box, see Chapter 3, Setting up the Analysis, or except the default which is 100, 
000 person-years at risk. The X axis is the variable time. A light gray vertical line represents two 
months and each vertical block represents a year. 

1989 1990 1991 1992 1993 1994 
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Cailtipn«   Forthetime series graph to produce accurate results three years of data or more 

must be used in order for EPISYS to calculate a three-year moving average for the 
annual trend (green or light gray shading). 

Printing Time Series and Spectral Density Analysis 

O    Select the Spectral Density Analysis or Time series analysis option from the DATABASE 
EXTRACTION - OUTPUT dialog box. 

©    Choose the PRINT Push button. 

The graph will display in black and white. 

©    Choose Print from the Print menu. 

mi&fi>ffffF&fmmm%<i^^ 

9\[pie:     If you are viewing a color graph you will not be able to print, however, yöü can capture the 
image using a capture program provided with EPISYS, see the section titled, "Creating a 
Graphic File for your Color Graph," on page 39.         ■■..-• 

....    .    — „   I ^-   ..     ,. ,;.«..   ff ■     T^T"^T ..  „ ;     "   ' '   "      ■■   .'      ■'■ 

The Print dialog box will appear. 

@    Choose the SETUP push button. 

©    Choose the Landscape option button located in the 
lower left corner of the Print Setup dialog box. In 
order for your graph to fit on an 8 Vi by 11 page of 
paper it must be set at landscape orientation. 

©    Choose the OK push button. 

This will return you to the previous dialog box. 

©    Choose the OK push button. 

hl'.'.tj. "■■ Irrra 

P £•)«* miter 
\cvnrM, HP UwM 4W4MV PoicSc** °» IPIVI 
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Oncnlahon ; 

. .      C Pop* 
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:&MfC«:>|AutoSelecl Tiay ^| 

Figure 4.6 Print Setup dialog box. 

Creating a Graphic File for a Color Graph 

You can save your color graph output as a PCX file to print or display in another program. 

When viewing the color graph on a computer screen . . . 

O    Press down the Ctrl key and the F5 key simultaneously. 

You well get a cross "+" on your computer screen 

©    Drag the "+" with your mouse over the area you want to capture. 
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©    Release the mouse button. 

The Save As dialog box will appear. 

@   In the File name: text editing box type a file name 

The default extension .PCX will be added to 
your file name unless you type a different 
extension. 

@   In the Directories: list box, choose the 
directory in which you want to save the file 
(Double-click the directory.) The default 
directory is C:episys. 

File None. Dgectonet: 

ars c VotKoeVwpvnnyg.  Vpoy* 1         °*         1 

Liil File» of Tjpe- 

E 

^ Ü 

eäe:\                          J 
(■^ office                         if: 
Q wpwin                     0 
Ql giaphict                ?£> 

- 
Drix«r 

1      Cancel      | 

J   HeJwo*.„J 

1 PCX - Zioft Pamlbiuih J |Sc:lbml35                  Cj 

Figure 4.7 Save As dialog box. 

©   If you want to save the file on a different 
drive, select the drive you want from the Drives: list box. Click the arrow on the right hand-side 
of the list box to display the drives. Drag your mouse to highlight the drive letter and release. 

©    Choose the OK push button. 

Univariate Analysis 

Before you perform a univariate analysis you need to extract the database. See the section titled, 
"Database Extraction," on page, 35. 

You only need to select one dependent variable 
(illness code) to perform a univariate analysis. 

©    Choose Perform Univariate Analysis from 
the Univariate menu. 

©    Choose the OPEN push button. 

©    Select a filename by pointing to the name 
and clicking with your left mouse button. 

0    Choose the OK push button. 
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It will take several minutes to load the database. Figure 48 Univariate Ana'ysis dial°g bo*- 
After the database is loaded, a list of the variables you selected will be displayed on the left hand side 
of the screen along with all 1,2 or 3-way analysis. To view the entire screen use the up and down 
scroll arrows located on the right-hand side of the list box. 

©    Select a univariate analysis (for example, Sex by Age) by clicking with your left mouse button. 
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9\0te.:    If you want a list of variable breakdowns to be included on the univariate output, click the 

Append Variables option box in located the upper right-hand corner of the dialog box. 
The Calculate SIRS option boxwill provide Standard Incidence Ratios(SIRs) forage 
classes. SIRs use the total US Navy enlisted population to adjust for the effect of age on 
illnesses. This option will be selected by default. The univariate analysis must include the 
variable age in order to calculate SIR's. 

©    Choose the CALCULATE push button to perform a univariate analysis on your variable 
selection. 

It will take several minutes to calculate, wait until the dialog box disappears before proceeding. 

0    Choose the SHOW push button to view the results in the WnBrowse editor. 

Univariate Results 

The following numeric annotations refer to Table 4.1 on page 43. 

The following example provides Standardized Incidence Ratios (SIR) for age. These results will only 
appear if you check the Calculate SIR option on the Univariate Analysis dialog box and you select 
age as one of your variables. 

®     The Univariate variable(s) you selected in the Univariate Analysis dialog box. In this example a 
2-way Univariate analysis was selected with Race and Age as the variables. 

®     Cases per 10000 Person-years at Risk. You can modify the population unit constant (k) from 
no scaling factor to 100,000 person-years at risk in the Database -Global Definitions dialog box. 
The default value is 100,000 person-years at risk. 

®     Confidence level This option can be modified in the Database-global definitions dialog box by 
setting the Type I error from .90 to .99. The default is .95. 

©     No of Cases A count of all occurrences meeting the Incidence/Prevalence criteria. In Table 4.1 
the Incidence/Prevalence criteria is lsl hospitalizations only, therefore number of cases would 
only count the lsl hospitalizations for each illness and excluded multiple hospitalizations from 
the count. 

© Per-Yrs at Risk Counts the number of years each case (person) contributes to the total. For 
example, if a person worked 4 years they would contribute 4 person years to the total person 
years at risk. 

©     Incidence Rate The number of cases (1st hospitalizations) per the (k) scaling factor by illness, 
age group, and race. In Table 4.1 the rate would be the number of cases per 10,000 (Refer to 
Appendix F for a detailed description on how EPISYS calculates incidence rates). 

In the example, the incidence rate for white 17-19 year olds was 91.05 per 10,000 person years at risk 
calculated as follows 

®/(D (©) = © 
6183/679079 (10000) = 91.05 

®     Confidence Limits The confidence limits (upper and lower) tells you the range within which 
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the true incidence rate (©) is likely to fall. In the example shown, the 95% confidence level (©) 
for white enlisted between the ages 17-19 is 88.78 to 93.32 per 10000 person-years at risk. 

Totl pop inc rate The Incidence rate for all U.S. Navy enlisted personnel (all races) for the 
selected illness(s), time period and age group. 

Expected No Cases This is the number of expected cases and is calculated by taking the total 
age-specific rate (®) and multiplying the age-specific person-years at risk (©). 

Standardized Incidence Ratio (SIR) is the observed number of cases divided by the expected. 
An SIR of 1.0 indicates no difference between observed and expected i.e. no excess risk. An 
SIR of 3.0 indicates a three times greater incidence than expected 

In the example, the standardized incidence ratio for All age groups among black enlisted 
personnel was 1.44 or 44% higher than the total Navy's enlisted population after taking into 
account the effect of age (Refer to Appendix F for a detailed description on how EPISYS 
calculates standardized incidence ratio's). 
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Saving Univariate Output 

After you have calculated a Univariate analysis you can save the output under a filename for later viewing. 

©    Choose the SAVE push button from the 
UNIVARIATE ANALYSIS dialog box. 

©    Type a file name in the text editing box. 
EPYSIS will only accept eight characters for 
file names and automatically adds an .euq 
extension to you eight character file name. 

ISAVE ANALYSIS ■fg 
~ - . 

1          Enter Hameofftnalusts to Save          1 

^OK w&ßxxi 

Figure 4.9 Save Analysis dialog box. 

©    Choose the OK push button. 

Viewing a Previously Saved Univariate Analysis 

©    Choose Review Univariate Analysis from the Univariate menu. 

©    Select a file name by pointing to the name and 
clicking with your left mouse button. 

©    Choose the SHOW push button. 

Your output will be displayed in WnBrowse a 
windows editor, read chapter 5, Using WnBrowse, 
to learn how to use the editor. 

0    Choose the OK push button after you are 
finished viewing the univariate analysis 
outputs. 

UNIVARIATE ANALYSIS - OUTPUT IS 

Select an Output Option 
Press SHOW 

Press OK When Done 

ageuiraLeuq 
raeeage.euq 
sex.euq 

SHOW 

j^jSR] 

Figure 4.10 Univariate Output dialog box. 

Multivariate Analysis 

You will have need to select two or more dependent variables (illness codes) from the DATABASE-DEFINITION dialog box to 
perform a multivariate analysis. 

3fr>^!<S*IM*g3=Si-M^^ 

9\OiZ:     Before you perform a multivariate analysis you need to extract the database, see the section 
titled, "Database Extraction", on page 35.  

^gggj^g^^^^^*gg^^^^^ 

CailtiOnS   A group of illness codes (selected by giving a range or choosing major or minor 
categories) is consider one dependent variable. The group of illnesses is considered the 
unit of measure and therefore counted as one dependent variable. If you want to run a 
multivariate analysis on a range of codes or one minor/major illness category, you will 
 need to list the codes individually.  
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O    Choose Perform Multivariate Analysis from 
the Multivariate menu. 

©    Select a file name by pointing to the name and 
clicking with your left mouse button. 

A warning will appear if the file name you choose 
does not have two or more dependent variables 
(illness groups). If this happens you will not be able 
to perform a Multivariate analysis on this filename. 

©    Choose the OK push button. 

MULTIVARIATE ANALYSIS 

List of Existing Databases 
Select One 

then 
Click OK to Continue 

jennife.ebr 
mutti.ebr 
preg.ebr 
tubercu.ebr 
uiraLebr 

• OK 

# 
Cancel 

Figure 4.11 Multivariate Analysis dialog box. 

It will take several minutes to perform a Multivariate analysis. A dialog box will appear with a status bar and the percent of 
extraction completed. Wait until the dialog box disappears before attempting to review the output. 

Reviewing your Multivariate Output 

There are several ways to review your multivariate 
analysis: Review Classification, Two-Way Tables, 
and Multi-Discriminants. The last two options on the 
Multivariate menu, Stratifications and Sample 
Allocations, allow you to evaluate sampling strategies 
for the selected ICD-9/NHRC illness codes. 

1 Multivariate       ^^^^^^^^^^^ 

Perform Multivariate Analysis 

Review Classifications 

Review Two-Way Tables 

Review Multi-Discriminants 

Review Stratifications 

Review Sample Allocations: 

T^^^mTTZZTZ7TT5^^^^!^SSZ^S71Z!^Za^^?l ^ta-äifeä&ttijaweg»^ 

9^pte:     In order to display all the information on your computer screen, some terms in the statistical 
output will be abbreviated. For example, Platforms use acronyms. To decipher the 

     abbreviations refer to the appropriate Appendix.  ___^ 
>•».->.•.■».»-     **•■'. •■■!.■-■•» ^rt 

Reviewing Classifications 

Reviewing classifications allows you to perform a 
cluster analysis on illnesses codes (NHRC or ICD-9 
codes) and time (months). You can statistically 
group the NHRC/ICD-9 codes into strong 
interrelated subgroups in relation to time (Month). 
You have the option to view the statistical 
documentation and a graphical dendrogram of the 
cluster. 

O    Choose Review Classifications from the 
Multivariate menu. 

MULTIVARIATE ANALYSIS- CLASSIFICATION 

AMiMHeAiMlyw» 
ChooevOne 

Choose Arabs« Option 
PrertPtOimBHT Button 

Pree» OK when Done 

Amlyat« Opfon« 

<* 1Documentation CyCJBjoSyl',; 

> Documentation by Month 

> Dendrogram by Category 

> Dendrogram by Month   ' 

Figure 4.13 Analysis Classification dialog box. 
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©    Select a filename by pointing to the name and clicking with your left mouse button. 

©    Select an analysis option (Documentation by Category, Documentation by Month, Dendrogram by Category or Dendrogram by 
Month) located on the right-hand side of the dialog box by clicking the option with your mouse. (See explanation of options 
page starting on page, 46). 

©    Choose the PLOT push button if you want to view the results in color and choose the PRINT push button if you want to 
your results in black and white. 

view 

j     ,.,■%..*-.**.    w r.  . ■»... ■    i.. 

9{pte.:     There is no difference between the PLOT and PRINT push button if you choose either the 

Documentation by Category or the Documentation by Month option. 
^^S^^S^^^^S^^^^^^^-^ 

Documentation by Category and Month 

Statistical documentation for Dendrogram by Category and Month. 

'■t''ixmff>*^»l&>*kMi>*$£^^ 

■%< WnBrowse-atLcd r :-;:■ HE3I3 
tile    Edit   ieatch Wcw   Options   belp 

The statistical documentation fl|"l»li£ wi-ÄT^raiErsT^ranTftTöTsa 
shows the linkages between 

HtfLTIVARIATE CLUSTER ANALYSIS 1 
the independent and 
classification variable along 
with the similarity 
coefficient, the probability 

Classification Variable    : 
Independent Variable           : 
Similarity Coefficient      : 

# Classificatin Variables: 
§ Independent Variables    : 

NHRCCODE 

HOWTH 

Pearson 

29 
12 

f\ 
the linkage is not due to CYCLE LIMKED COEF CCCS ZL zu                                   >p 

chance alone (CCCS), and 
the upper (ZU) and lower 
(ZL) bounds on the 

1 

1 

1 

1 

1 

1 

2 
3 

5 

6 

14 

16 

25 
12 
26 

7 
IS 
28 

0.9307 
0.8418 
0.5000 
0.8609 
0.8627 
0.9284 

1.0000 

1.0000 

1.0000 

1.0000 

1.0000 

1.0000 

1.0000 
1.0000 
1.0000 
1.0000 
1.0000 
1.0000 

1.0000                                               p 
l.oooo                                 >'■■>■ 
l.oooo                           ■■.;. 
l.oooo                                 ■;-> 
1.0000                                                                  KJK 
1.0000                                              ':■!: 

probability. 1 17 18 0.9755 1.0000 1.0000 1.0000                                                    -V. 
1 19 27 0.9363 1.0000 1.0000 1.0000 
1 20 24 0.9670 1.0000 1.0000 1.0000                                              ?.' 
1 21 22 0.9522 1.0000 1.0000 1.0000 
2 2 14 0.7607 0.8116 o.oooo 0.9786                                              V 
2 3 9 0.8188 0.7246 0.7246 0.7246 
2 20 29 0.8605 0.9973 0.9973 0.9973                                               s|i; 

^int7^C0M^^^e4«    #:;.                                                                                     -■■-■■■ ,:^\  ■■ 

Figure 4.14 An example of Documentation by Category. 

Refer to Figure 4.14 for illustration of the following definitions. 

Classification variable: 
Independent variable: 
Similarity Coefficient: 
# Classification Variables: 
# Independent Variables: 

Ancillary variables being clustered. 
Month or NHRC/ICD-9 illness categories. 
Pearson. 
Total number of months (12) or number of NHRC/ICD-9 illness categories. 
Total number of months (12) or number of NHRC/ICD-9 illness categories. 

Acronyms used in the statistical documentation. 

COEF correlation coefficient for the two variables (Illness category and month) 
CCCS probability that the COEF is not equal to 0. 
ZL lower confidence limits of CCCS. 
ZU upper confidence limits of CCCS. 
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Dendrogram by Category and Month 

NHRC/ICD-9 categories or months are grouped into classes by cluster analysis and represented graphically as a Dendrogram. The 
darker lines within the body of the dendrogram represent linkages for which the probability that the entities linked belong to the 
same class is reflected on the X axis. 

Figure 4.15 gives an example 
of a dendrogram resulting from 
the classification of 29 major 
NHRC categories. The 29 
major NHRC categories are 
clustered and sub-grouped in 
relation to time. 

Figure 4.16 gives an example 
of a dendrogram with months 
as the classification variable. 

Variable: NHROICD9  Class Prob - 0,9330  Date: allma] 

Figure 4.15 Dendrogram with Major NHRC codes as the classification variable. 

Variobte: MONTH Class Prob - 0.9500  Data: i 

*,^.Ä—~\s* *  r*, : 

*&•. -"^v^i^S|i  I ' 'iAisllllfeJ|Illi§ 

Figure 4.16 Dendrogram with months as the classification variable. 

Two-Way Tables 

Two-way tables show graphically the incidence rates between any two variables selected. The darker the square the higher the 
incidence rate. 
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O    Choose Two-Way Tables from the Multivariate 
Menu. 

©    Select a filename by pointing to the name and 
clicking with your left mouse button. 

©    Click on an analysis option located on the right- 
hand side of the dialog box. 

MULTIVARIATE ANALYSIS - TWO-WAY TABLES 

Abatable Analyses 
Choose One 

Choose Analysis Option 
Pre«« PLOTMMT Button 

Press OK when Done 

muKUdr 

Anafcs» Options 

WROICDtx MOUTH 
NHROICDSxSex 
NHRCKOSxRKe 
NrlRCACWxAoe 
NHRC4C09x Grade 
NHRC<IC09xRate 
MrWC/ICOSxPtatforrri 
MONTH x Sex 
MONTH «Race 
MONTH «Age 
MONTH x Grade 
MOnTHxRate 
MONTH x Platform 

0    Choose the PLOT push button if you want to view    Figure 4.17 Multivariate 
the results in color and choose the PRINT push 
button if you want to view your results in black and white. 

iJHSfftS: 

rot: 

analysis-two way tables dialog box. 

Figure 4.17 is an example of a dot-density 
diagram with viral hepatitis and age as the analysis 
option variables. This figure shows the eight 
individual ICD-9 codes for viral hepatitis by age 
group. The darker a particular cell, the higher the 
incidence rate. Hepatitis B (ICD-9 code 07030) 
without mention of hepatic coma in the 25-29 age 
group represents the highest incidence rate. 

TWOJ 

Wral H<}, at NOS WO coma 
07090 

He; aSfii B WO coma 
07030 

Hep aäfis A WO coma 
07010 

■Wral Hcf at Nof Wccma 
07060 

"Krai Htfat NEC WO coma 
07050 

HqurWit B väh coma 
07020 

■SSral He;at KEC Wcoma 
07040 

HeparicU A iraßi coma 
07000 

■alhep 

Figure 4.18 Example of a dot-density diagram (Age & viral 
hepatitis). 

Multi-Discriminants 

riri^^T? ana,ly,SiS Sh°WS tW° VariabIeS and th£ir Similarity in temP°ral trends over the «™ Period selected You can 
name) documents (Documentation - variable name) or the graphical representation (Graphics - variable 
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MULTtVARtATE ANALYSIS - DISCRIMINANTS 

@ 

Available Analyses 
Choose One 

Choose Analysis Option 
Press PLOT 

Press OR when Done 

i'Analy^^ptiofts; - 

mufttejinei 

aB.emc  . 
rubcreu.emc 
preg.emc 

■■'•h'i1 =!IMIH!BM=1 
DOCUMENTATION. Race 

'»-Age 
DOCUMENT ATIOH - Grade 
DOCUMENTATION-Ra»e 

«- Platform 
GRAPHICS-Sex 
GRAPHICS-Race 
GRAPHICS-Age 
GRAPHICS-Grade 
GRAPHICS-Rote 
GRAPHICS ■Platform 

mem 

Choose Review Classifications from the 
Multivariate menu. 

Select a filename by pointing to the name and 
clicking with your left mouse button. 

Select an analysis option (Documentation — 
variable name or Graphics — variable name) 
located on the right-hand side of the dialog 
box by clicking the option with your mouse. 
See explanation of options starting on page 49. 

Figure 4.19 Multivariate analysis - Discriminants dialog box. 

Choose the PLOT push button if you want to 
view the results in color and choose the PRINT push button if you want to view your results in black and white or you want to 
print your output. 

'wci 

• ■  * v      • ......,.- ., .      . 

There is no difference between the PLOT and PRINT push button if you choose any of the 
Documentation — variable name options.   

;.        .   ."   .■-...    " m^m^k^^j^mm^ 

Graphics — variable name options 

Figure 4.19 & 4.20 are plots of the canonical variables hepatitis by sex and hepatitis by race. These figures show the individual 
ICD-9 codes grouped into four classifications based upon their similarity in temporal trends over a 14-year period plotted against 
sex and race. Both sex and race show strong discrimination for three of the eight ICD-9 viral hepatitis codes. This implies the 
hospitalization rates for this group is considerably different between males and females (higher in males and among race (higher in 
blacks). 

EPISYS-PHTOT 
frint    ßone 

Discriminant Class Regions Cviralhep  -  Sex)      Disci 

lr 
ers are the Discriminant Variable Classes Listed to the Bight 

»in»« Uixiible   Classes 

01090 -  VIRAL  HEPAT  H03  W0   COMA 
07050 -  HEPATITIS  E  WO   CQKft 

070J.O -  HEPATITI3   A WO   COMA 

07060 -  VIRAL  HEPAT  HOS  U  COMA 

07050 -  VIRAL  HEPAT  MEC  WO   C0HA 

07020 -  HEPATITIS  E  WITH  C0KA 

07040 -  VIRAL  HEPAT  MEC  U  C0HA 

07000 -  HEPATIT 13   A WITH  C0HA 

Figure 4.20 Multiple Discriminant graphical output (hepatitis by race). 
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Discriainant Class Regions (viralhep  -  Race) ■ Uitiall«  Cla 

ie£ are tne P"««™»™ Variable Classes Listed to ehe  Right,    07000 - HEPATITIS s wo COKA 

:':« 

iSfeSSs:*. 07010  - HEPATITIS  A WO COMA 

2:      01060  - VIRAL HEPAT WOS U COHA 

070S0  - VIRAL HEPAT BEC WO  COHA 

0:      07020 - HEPATITIS B WITH COHA 

4:      07090  - VIRAL HEPAT BEC W COHA 

07000  - HEPATITIS  A WITH COHA 

Figure 4.21 Multiple Discriminant graphical output (hepatitis by sex) 

Documentation — variable name options 

This is an example of the statistical documentation for multiple discriminant analysis. The explanations of this statistical 
documentation is beyond the scope of this manual. Please refer to the following statistical text for an explaination of multiple 
discriminant analysis: 

Harris, R. J. (1985) A Primer of Multivariate Statistics, 2nd edn. Orlando: Academic Press. Inc. 

MULTIPLE DISCRIMINANT ANALYSIS 

Discriminant Data Set: 
Ancillary Variable   :  Sex 

Discriminant Variable Classes 

Class-1 : 07090 
07030 
07010 

- VIRAL HEPAT NOS W/O COMA 
- HEPATITIS B W/O COMA 
- HEPATITIS A W/O COMA 

Class-2 : 07060 
07050 

- VIRAL HEPAT NOS W COMA 
- VIRAL HEPAT NEC W/O COMA 

Class-3 : 07020 - HEPATITIS B WITH COMA 

Class-4 : 07040 
07000 

- VIRAL HEPAT NEC W COMA 
- HEPATITIS A WITH COMA 

Variable 

Descriptive Statistics 

Mean    Var(total)   Var(among)  Var(within) 

Male 
Female 

2.3747e+00 
1.7688e+00 

8.0235e+00 
3.5787e+00 

1.2179e+00 
6.2456e-01 

1.7198e+00 
1.4178e+00 

Variable 

Eigenvector Statistics 

Eigenvalue     % Variance 

Male 
Female 

3.044682e+00 
9.291490e-02 

97.038660 
2.961340 
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Variable Eigenvectors  -■ -> 

Male 
Female 

7.4241e-01  -6 
6.6995e-01    7 

6995e- 
4241e- 

-01 
-01 

Variable Correlations  -■ -> 

Male 
Female 

9.9520e-01  -7 
9.8847e-01  -5 

6217e- 
7835e- 

-01 
-01 

Nunerator       df: 
Denominator df: 

Variable 

F-Tests  for Ancillary Variables 

F-Ratio      Probability- 

Male 
Female 

6.2204 
3.3656 

0.94361 
0.86357 

Pr  >  level  set  in Database Options 

Reviewing Stratifications 

EPISYS will evaluate the data you selected and statistically determine what variables need to be stratified. Follow the steps below to 
evaluate your data set. 

©    Choose Review Stratifications from the Multivariate menu. 

©    Select a filename by pointing to the name and 
clicking with your left mouse button. 

©    Select an analysis option (Sex, Race, Age, 
Grade, Rate or Platform) located on the right- 
hand side of the dialog box by clicking the 
option with your mouse. 

@    Choose the PLOT push button if you want to 
view the results in color and choose the PRINT 
push button if you want to view your results in 
black and white. 

MULTIVARIATE ANALYSIS -STRATIFICATION                                                     B 

Available Analyses 
Choose One 

Choose Analysis Option 
Press PLOWRINT Button 

Press OK when Done 

Analysts Options 

Sex 
Race 
Age 
Grade 
Rate 
Platform 

!i! 

PLOT 

HMMH                                                 -:'':''::"::: 

eiralhep.emc 
•ttemc 
tubercaemc 
preg.emc 

PRINT 

tfm 

Figure 4.22 Multivariate analysis stratification dialog box. 

Viewing the Results 51 



A graph will appear similar to Figure 4.22 . In this 
example the 45-61 age range is the only age 
disimilar from the other age groups. Therefore, the 
age variable only needs two age groups: 
45 and above and ages falling below 45. 

Reviewing Sample Allocations 

EPISYS can evaluate the selected data set and 
statistically determine the minimum sample size. 

Follow the steps to statistically determine the 
minimum sample size: 

O    Choose Review Sample Allocations from the 
Multivariate menu. 

©    Select a filename by pointing to the name and 
clicking with your left mouse button. 

©    Choose the SHOW push button. 

A text document will appear similar to Table 4.2 

STRATIFICATION - - Age - all 

Height of Horizontal Line Indicates Relative Magnitudes of Stratum Means 

• 4 ■ lljgp^P^^^lllP 

^^ 

Figure 4.23 Example of stratifications with age as the variable. 

MULTIVARIATE ANALYSIS - SAMPLING 

Available Allocations 
Choose One 

Press SHOW Button 

Press € : SHOW 

multi.uso 
all.vso 
tubercu.vso 
viralhep.vso 

ftm 
t^&KI 

Figure 4.24 Multivariate analysis -sampling dialog box. 
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Table 4.2 Sample Allocations for Sex, Race, Age and Grade 

Total Sample Size:  333 

Variable - Sex 

Stratum      Members  Proportion(%)  Sample Size 

Stratum 1:    Female      100.00 333 

Variable - Race 

Stratum      Members  Proportion(%)  Sample Size 

Stratum 1: Black 
White 
Other 

100.00 333 

Variable - 

Stratum 

Age 

Members Proportion(%) Sample Size 

Stratum 1: 45-61 1.08 4 

Stratum 2: 20-21 
17-19 
22-24 
40-44 
25-29 
35-39 
30-34 

98.92 329 

Variable - Grade 

Stratum      Members   Proportion(%)  Sample Size 

Stratum 1: E3 19.97 67 

Stratum 2: E2 11.49 38 

Stratum 3: El 9.16 31 

Stratum 4: E4 59.38 198 
E9 
E5 
E8 
E6 
E7 

The Method for applying sample sizes is as follows: 

(1) Select one of the variables listed to use 
as the basis for sampling. 

(2) Randomly choose from within each stratum 
the number of encounters indicated. 

(3) Choose encounters randomly from among the 
variable realizations included in the stratum. 
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Printing 

You can print the entire file or a selected portion of a file. The Print dialog box allows you to set 
margins and define headers and footers. You may also print a file using the default printer font and 
not the currently selecting viewing font. 

O    Choose Print from the File menu 

or choose the PRINT 
push button. 

The Print option dialog box will 
appear. 

Open... 

Save As... 

Close File ^ 

Previous File Ctri+PGUP 
Next File Ctri+PGDN 

Print- 
Printer Setup- 

Show information... 

Exit Esc 

Figure 5.1 The File Menu. 

Adding Headers and Footers to the Output 

If the Print headers and footers option box is selected the dialog box will expanded to include two 
extra edit boxes, one for the header text and one for the footer text. You may use the default values, 
or select your own. Along with the text in the header and footer string, you can include the following 
special codes: 

Print Options 

Print What 

• Entire File 
> Selected Portion only 

Margins 

Options 

&d - inserts the current date 
&t - inserts the current time 
&p - inserts the current page number 
&f - inserts the file name 

Along with the special codes, you can 
use the V character to left justify, 
right justify and center the text 
contained in the headers and footers. 
For example: 

File name/page/Date 

Will print the word "File" left 
justified, the word "Date" right 
justified and the word "page" in the center of the page. 

//Page &p 

Vc 

laftP Top. 0.5      jBoiont:0.5 

tfl Use gefault printer font 

_i Process Form Feeds 
HI Print headers and footers 

Header:   lviral search 

Footer:     /-8p- 
7 Het: 

Figure 5.2 Print Options dialog box. 

Prints "Page n" right justified 

Using the Search Features 

All search features are located under the Search Menu. 
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To search for a text or numeric string ... 

O    Choose Find from the Search menu. 

©    Type a word or word part in the Find 
What: text editing box. 

©    You can specify the direction of the 
search, backwards or forwards by 
clicking the option in the Direction 
option box. 

o You can specify from where the 
search commences. Entire Scope 

Find What: viral                                _-] 
J^QK   " 

Hex:                                  iül 

Direction                      Origin ::jjfencel 
4 {Forward 
> Backward 

Options 

4 Entire Scope 

> Current Position 

Li Match Upper/Lower case 
_] Scroll to Top 

Figure 5.3 Find dialog box. 

searches form the top or bottom of the file. Current Position searches from the top or bottom of 
the current window. 

©    If you want your search to be case sensitive click the Match Upper/Lower Case option. 

WnBrowse will identify the word or word part by highlighting the string, however, unless you specify 
by clicking the Scroll to Top option box the highlighted word will not scroll to the top of the screen. 
If you do not want to scroll for the string of text check the Scroll to Top option box. 

©    Choose the OK push button to begin your search. 

Repeat Last Find 

You can repeat your previous search without pulling up the Find dialog box. 

©    Choose Repeat Last Find from the Search menu. 

WnBrowse 
A warning will appear if no occurrences 
are found. 

Figure 5.4 Warning dialog box. 

Goto 

The Goto command allows you to position your curser on a different line number. 

©    Choose Goto from the Search menu. 

©    Enter a line number and choose the OK push button. 
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Selecting Text 

You can use a mouse to select text from the file being browsed. The selected text is displayed in a 
different color to distinguish it from the unselected text. You can copy selected text to the clipboard, 
print it on an attached printer, or save it to a file. 

O Move the cursor to the first or last character you wish to select. 

© Press and hold the left mouse button. The cursor will change. 

© Drag the mouse, up or down, left or right, until you have selected the required text. 

0 Release the mouse button. 

V^Ote:    If you move the: mouse above or below the WnBrowse window, the text will be scrolled 
;■ while being selected.  .■---. 

;**^"2>'^)ig*2j£g'tt«j&^£ 

9{pte:    If you want to select a large portion of the file, click and hold the mouse before the first 

character required, then press the Page-Down key to select text a page at a time. 
sMM^MMHMl!LM***x»i£edll*MÜ^^ 

Selecting All Text 

You can select the entire contents of a file. 

O    Choose Select All from the Edit menu. 

i^i^^mi^K^^^!a»m>^^^^. 

9{gt£:     Selected text can be copied to the Windows clipboard, printed, or saved to a file. 
3^^<jj^^s^^^^^MH33^^siaa^s^ig^^a^^^^aE^^ 

Selecting Screen and Printer Fonts 
raiffi E 

Font. Fontsttfe-. Size: 
M<3Eifl)|fly Regular 9 

WL 
10 ~^ 
11 
12   '■ 
14  —' 
IS 
18 
20   > 

h::m,,| 
Italic 
Bold 
BolcSllalii 

**fc EngraversGo'hicBT    jj 
Frxedsys 

^ Footlighl MT Lighi 
5 Garamond 
fGeoSlab703UBT 

Cancel    | 

lfc Haettenschweilet        >1 
■       : 

WnBrowse supports fonts for both 
displaying and printing the selected file. 
Fonts are selected by using the Select Font   ; 
command from the options menu. The 
number of fonts available will vary 
according to the currently selected printer. 

O    Choose Select Font from the Options 
menu. 

©    Select a font, style and size by 
^«,^li:„™ »u_„..™u .u« r„. •  The« a TrueType font This sain» font i*ä be usedonboih scrolling through the list. v J»»««»"'«WJ«"P*«» 

■Sempte- 

AaBbYyZ; 

Sejipt 

Figure 5.5 Fonts dialog box. 
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©    Choose the OK push button. 

CautlOn:  All EPISYS output uses Courier New, font size 9 because it is a nonproportional or 

fixed-pitch font, meaning each character takes up the same amount of space. If you 
change the font type, me columns will not line up and if you increase the point size 
the information will riot fit on the screen; 

Button Bar 

The WnBrowse button bar allows you to do many operations with a single click of a mouse button. 
The following buttons are available. If the button bar is not displayed you will need to choose 
Display Button Bar from the Options menu. 

m 
m 

ABi 

Displays the file open dialog box. 

Browse the previous file. 

Browse the next file. 

Print the current file. 

Display information about the current file. 

Copy selected text to the Windows clipboard. 

Search the file for a character string 

Repeat the previous search. 

Display the file in the text view mode. 

Display the file in the hex view mode. 

Display the files contained within a ZIP file. 

Select a font. 

Set your color preferences. 

Display the WnBrowse help. 

Launch the file with it's associated application. 

Redisplay the previous ZIP file 

Close the current file and Iconize 
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9{pte:    If a button is disabled then it will be grayed and will not go down when it is clicked. For 

example, the clipboard button is disabled when there is no selected text, and the launch 
button is disabled when the file has no associated application,  \ 

f^y^^^^^^^^^^^^^^i ^BMsmBmBtemBmsmsamsmKammmmmMSBBBsaam 
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Major and Minor Illness Categories: 

The following list is of major and minor illness categories each category is sorted by 
their major code, just as it appears in the major and minor dialog boxes. There are 29 
major illness categories and 1,018 minor illness categories. 

Scoter    Both ICD-9 and NHRC codes are grouped into the 

following 29 major illness categories and 1,018 minor 
illness categories. 

Major Minor 
Code      Major Code Title Code Minor Code Title 

V: 

V: 

V: 

V 

V 

V 

V 

V 

V: 

V: 

V: 

V 

V 

V 

V 

V 

V 

V 

V 

V: 

V: 

iral Diseases 48 Measles 

iral Diseases 49 Rubella 

iral Diseases 45 Chickenpox 

iral Diseases 46 Herpes zoster 

iral Diseases 47 Herpes simplex 

iral Diseases 43 Smallpox 

iral Diseases 40 Acute Poliomyelitis 

iral Diseases 41 Meningitis Aseptic (Enterovirus) 

iral Diseases 42 Enteroviral Disease ENS Other 

iral Diseases 44 Cowpox 

iral Diseases 50 Viral Exanthemata Other 

iral Diseases 51 Yellow Fever 

ral Diseases 52 Dengue 

ral Diseases 53 Encephalitis Viral Mosquito-Borne 

ral Diseases 54 Encephalitis Viral Tick-Borne 

ral Diseases 55 Encephalitis unspecified 
Arthropod-Borne 

ral Diseases 56 Encephalitis Acute Epidemic 

ral Diseases 57 Encephalitis Viral 

ral Diseases 58 Hemorrhagic Fever 
Arthropod-Borne 

ral Diseases 59 Hemorrhagic Fever Epidemic 

ral Diseases 60 Viral Arthropod-Borne Other 
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Major 
Code Major Code Title 

Minor 
Code Minor Code Title 

Viral Diseases 61 Hepatitis Viral 

Viral Diseases 62 Rabies 

Viral Diseases 63 Mumps 

Viral Diseases 65 Coxsackie Virus Disease 

Viral Diseases 66 Mononucleosis Infectious 

Viral Diseases 68 Viral Disease Conjunctiva Other 

Viral Diseases 69 Viral Disease Other 

2 Bacterial Diseases 1 Cholera 

2 Bacterial Diseases 2 Typhoid Fever 

2 Bacterial Diseases 3 Paratyphoid Fever 

2 Bacterial Diseases 4 Salmonella Infection Other 

2 Bacterial Diseases 5 Dysentary Bacillary 

2 Bacterial Diseases 6 Food Poisoning Bacterial 

2 Bacterial Diseases 10 Diarrheal Disease 

2 Bacterial Diseases 22 Plague 

2 Bacterial Diseases 23 Tularemia 

2 Bacterial Diseases 24 Anthrax 

2 Bacteria] Diseases 25 Brucellosis 

2 Bacterial Diseases 26 Glanders 

2 Bacterial Diseases 27 Melioidosis 

2 Bacterial Diseases 28 Rat-Bite Fever 

2 Bacterial Diseases 29 Bacterial Disease Zoonotic Other 

2 Bacterial Diseases 30 Leprosy 

2 Bacterial Diseases 32 Diphtheria 

2 Bacterial Diseases 33 Whooping Cough 

2 Bacterial Diseases 34 Streptococcal Sore Throat/Scarlet 
Fever 

2 Bacterial Diseases 35 Erysipelas 

2 Bacterial Diseases 36 Meningococcal Infection 

2 Bacterial Diseases 37 Tetanus 
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Major 
Code Major Code Title 

Minor 
Code Minor Code Title 

2 Bacterial Diseases 38 Septicemia 

2 Bacterial Diseases 39 Bacterial Disease Other 

3 Mycobacterial 
Diseases 

12 Tuberculosis Pulmonary 

3 Mycobacterial 
Diseases 

13 Tuberculosis Other Respiratory 

3 Mycobacterial 
Diseases 

14 Tuberculosis Meninges CNS 

3 Mycobacterial 
Diseases 

15 Tuberculosis 
Intestine/Peritoneum/Mesenteric 

3 Mycobacterial 
Diseases 

16 Tuberculosis Bones and Joints 

3 Mycobacterial 
Diseases 

17 Tuberculosis Genitourinary System 

3 Mycobacterial 
Diseases 

18 Tuberculosis Other Organs 

3 Mycobacterial 
Diseases 

19 Tuberculosis Disseminated 

3 Mycobacterial 
Diseases 

20 Tuberculosis Late Effects 

3 Mycobacterial 
Diseases 

21 Tuberculosis Unspecified Site 

3 Mycobacterial 
Diseases 

31 Mycobacterial Disease Other 

4 Rickettsial Diseases 72 Rickettsiosis Tick-Borne 

4 Rickettsial Diseases 64 Psittacosis 

4 Rickettsial Diseases 73 Rickettsiosis Tick-Borne 

4 Rickettsial Diseases 70 Typhus 

5 Chlamydial Diseases 67 Trachoma 

6 Sexually Transmitted 
Diseases 

80 Syphilis Congenital 

6 Sexually Transmitted 
Diseases 

81 Syphilis Early Symptomatic 

6 Sexually Transmitted 
Diseases 

82 Syphilis Early Latent 
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Major 
Code Major Code Title 

Minor 
Code Minor Code Title 

6 Sexually Transmitted 
Diseases 

83 Syphilis Cardiovascular 

6 Sexually Transmitted 
Diseases 

84 Syphilis CNS 

6 Sexually Transmitted 
Diseases 

85 Syphilis Other and Unspecified 

6 Sexually Transmitted 
Diseases 

86 Syphilis 

6 Sexually Transmitted 
Diseases 

87 Gonococcal Infection 

6 Sexually Transmitted 
Diseases 

88 Venereal Disease Other 

6 Sexually Transmitted 
Diseases 

13 Trichomoniasis Urogenital 

7 Fungus Diseases 94 Dermatophytosis 

7 Fungus Diseases 95 Dermatophytosis Other/Unspecified 

7 Fungus Diseases 96 Moniliasis 

7 Fungus Diseases 97 Actinomycosis 

7 Fungus Diseases 98 Coccidiomycosis 

7 Fungus Diseases 00 Blastomycosis 

7 Fungus Diseases 01 Fungus Other 

8 Spirochete Caused 
Diseases 

78 Relapsing Fever 

8 Spirochete Caused 
Diseases 

89 Leptospirosis 

8 Spirochete Caused 
Diseases 

90 Vincent's Angina 

8 Spirochete Caused 
Diseases 

91 Yaws 

8 Spirochete Caused 
Diseases 

92 Pinta 

8 Spirochete Caused 
Diseases 

93 Spirochete Infection Other 

9 Protozoal Diseases 74 Malaria 

9 Protozoal Diseases 75 Leischmaniasis 
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Major 
Code Major Code Title 

Minor 
Code Minor Code Title 

9 Protozoal Diseases 76 Trypanosomiasis American 

9 Protozoal Diseases 77 Trypanosomiasis Other 

9 Protozoal Diseases 12 Toxoplasmosis 

9 Protozoal Diseases 7 Amebiasis 

9 Protozoal Diseases 8 Protozoal Intestinal Disease Other 

10 Ectoparasites 114 Pediculosis 

10 Ectoparasites 115 Acariasis 

10 Ectoparasites 116 Infestation Other 

10 Ectoparasites 117 Arthropod Other 

11 Worm Caused 
Diseases 

102 Schistosomiasis 

11 Worm Caused 
Diseases 

103 Trematode Infection Other 

11 Worm Caused 
Diseases 

104 Hydatidosis 

11 Worm Caused 
Diseases 

105 Cestode Infection Other 

11 Worm Caused 
Diseases 

106 Trichiniasis 

11 Worm Caused 
Diseases 

107 Filarial Infection 

11 Worm Caused 
Diseases 

108 Ancylostomiasis 

11 Worm Caused 
Diseases 

109 Helminthiasis Intestinal Other 

11 Worm Caused 
Diseases 

110 Helminthiasis Other/Unspecified 

11 Worm Caused 
Diseases 

111 Intestinal Parasitism Unspecified 

12 Uncertain Etiology 118 Sarcoidosis 

13 Neoplasms 1002 Neoplasm 

14 Metabolic Diseases 1003 Endocrine/Nutrition/Metabolic 

15 Diseases of Blood 1004 Blood/Blood-Forming Organs 

16 Mental Disorders 1005 Mental Disorder 
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Major 
Code      Major Code Title 

Minor 
Code       Minor Code Title 

17 Nervous 
System/Sense Organs 

18 Diseases of 
Circulatory System 

19 Diseases of 
Respiratory System 

20 Diseases of Digestive 
System 

21 Diseases of 
Genitourinary System 

22 Complications of 
Pregnancy/Childbirth 

23 Diseases of 
Skin/Subcutaneous 
Tissue 

24 Diseases of 
Musculosketal 
System 

25 Congenital 
Anomalies 

26 Perinatal 
Morbidity/Mortality 

27 Symptomatic/IIl- 
Defined Conditions 

28 Accident/Poisoning/ 
Violence 

29 Supplementary/ 
Special Conditions 

1006        Nervous System/Sense Organs 

1007        Circulatory System 

1008        Respiratory System 

1009        Digestive System 

1010        Genitourinary System 

1011 Pregnancy/Childbirth 

1012 Skin/Subcutaneous Tissue 

1013 Musculoskeletal System 

1014 Congenital Anomaly 

1015 Perinatal Morbidity/Mortality 

1016 Symptomatic/Ill-Defined 

1017 Accident/Poisonina/Violence 

1018 Supplementary/Special 
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Major Illness Categories 

Sorted Numerically by Illness Code 

1 Viral Diseases 
2 Bacterial Diseases 
3 Mycobacterial Diseases 
4 Rickettsial Diseases 
5 Chlamydial Diseases 
6 Sexually Transmitted Diseases 
7 Fungus Diseases 
8 Spirochete Caused Diseases 
9 Protozoal Diseases 
10 Ectoparasites 
11 Worm Caused Diseases 
12 Uncertain Etiology 
13 Neoplasms 
14 Metabolic Diseases 
15 Diseases of Blood/Blood-Forming Organs 
16 Mental Disorders 
17 Nervous System/Sense Organs 
18 Diseases of Circulatory System 
19 Diseases of Respiratory System 
20 Diseases of Digestive System 
21 Diseases of Genitourinary System 
22 Complications of Pregnancy/Childbirth 
23 Diseases of Skin/Subcutaneous Tissue 
24 Diseases of Muscoloskeletal System 
25 Congenital Anomalies 
26 Perinatal Morbidity/Mortality 
27 Symptomatic/Ill-Defined Conditions 
28 Accident/Poisoning/Violence 
29 Supplementary/Special Conditions 
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Major Illness Categories (cont'd) 

Sorted Alphabetically by Title 

28 Accident/Poisoning/Violence 
2 Bacterial Diseases 
5 Chlamydial Diseases 
22 Complications of Pregnancy/Childbirth 
25 Congenital Anomalies 
24 Diseases of Muscoloskeletal System 
18 Diseases of Circulatory System 
23 Diseases of Skin/Subcutaneous Tissue 
15 Diseases of Blood/Blood-Forming Organs 
19 Diseases of Respiratory System 
21 Diseases of Genitourinary System 
20 Diseases of Digestive System 
10 Ectoparasites 
7 Fungus Diseases 
16 Mental Disorders 
14 Metabolic Diseases 
3 Mycobacterial Diseases 
13 Neoplasms 
17 Nervous System/Sense Organs 
26 Perinatal Morbidity/Mortality 
9 Protozoal Diseases 
4 Rickettsial Diseases 
6 Sexually Transmitted Diseases 
8 Spirochete Caused Diseases 
29 Supplementary/Special Conditions 
27 Symptomatic/IU-Defined Conditions 
12 Uncertain Etiology 
1 Viral Diseases 
11 Worm Caused Diseases 
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NHRC Illness Classification System 

The NHRC illness classification system was developed to maintain in-house consistency 
and to include illnesses which were only evident in the naval occupational environment. 
The International Classification of Disease (ICD-9) is the most commonly used illness 
classification system used by the medical community, however, when new illnesses arise 
codes may change. Naval Health Research Center needed a coding system which remain 
the same when new codes were added. In addition, Naval Health Research Center had to 
create codes that were specific to the naval occupational environment, for example, war 
time injuries and illnesses. In addition certain illnesses were broken down further for 
research purposes. 

Currently injuries and diseases are grouped into 29 major diagnostic categories (See 
Appendix A for a list of major illness codes). 

Printing a List of NHRC Codes and Descriptions 

Choose the 
CODES push 
button from the 
NHRC/ICD9 
CODES dialog 
box. 

DEFINE DATABASE - MHRC / ICD9 CODES 

if Enter muCar BOS edde*:f wmC 1 ICM Code Samples 

RaftOB'of 

Code:   1ZMS 

Coden:   1234a-17M0 

codec   ily 

rc-.c 

•* 
}'^'^y A'i: w-^ 

Figure B.l NHRC/ICD9 CODES dialog box 

©       Choose either 
BROWSE push 
button. 

DATABASE - CODE SEARCH 

fW In lira Appropriate Ficht    :f 

PTM* FHB r«:*pacffic code::: 
■f   Pro.. BROWSE tar .a coo« 

Preee OK whea done 

HHRC or JO» Code muet be 
• compiet 

Code Seertftta not Ctce Sensitive 

TbeTett Search String meybe 

ma» bo a *t*»i* of die 
Texttfawcriptton 

,.;!M^«i^sw«0v' 

m?$&-> ■.■■ Text-Searchh>no*CweSeratWwe ■■■ 

Figure B.2 CODE SEARCH dialog box 

This will display all the NHRC codes and ICD-9 codes in WnBrowse, a windows editor. 

©       Choose Print from the File menu. 

The Print Options dialog box will appear with the defaults appropriately set. To learn 
how to change the options read Chapter 5, Using Wnbrowse. 

©       Choose the OK push button. 
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Occupation Rate Codes and Titles 

The Bureau of Naval Personnel produces and updates the occupational rate codes periodically.' 

Sorted by Rate Code 

Only includes naval enlisted personnel occupations 

Rate Code      Occupational Title 

0100-BM Boatswains Mate 

0150-MA Master-at-Arms 

0200-QM Quartermaster 

0250-SM Signalman 

0300-OS Operations Specialist 

0350-EW Electronics Warfare Technician 

0400-ST Sonar Technician 

0450-OT Ocean Systems Technician 

0500-TM Torpedoman Mate 

0600-GM Gunners Mate 

0610-WT Weapons Technician 

0700-FC Fire Controlman 

0800-FT Fire Control Technician 

0810-MT Missile Technician 

0900-MN Mineman 

1000-ET Electronics Technician 

1010-DS Data Systems Technician 

1080-PI Precision Instrumentman 

1100-IM Instrumentman 

1200-OM Opticalman 

1400-NC Navy Counselor 

1500-RM Radioman 

1600-CT Communications Technician 

1700-YN Yeoman 

1750-LN Legalman 
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Rate Code Occupational Title 

1800-PN Personnelman 

1900-DP Data Processing Technician 

2000-SK Storekeeper 

2100-DK Disbursing Clerk 

2200-MS Mess Management Specialist 

2300-IS Intelligence Specialist 

2490-SH Ships Serviceman 

2500-RP Religious Program 

2600-JO Journalist 

2700-PC Postal Clerk 

3100-LI Lithographer 

3200-DM Illustrator Draftsman 

3300-MU Musician 

3600-SN Seaman 

3700-MM Machinists Mate 

3800-EN Engineman 

3900-MR Machinery Repairman 

4000-BT Boiler Technician 

4100-EM Electricians Mate 

4200-IC Interior Comm Electrician 

4300-HT Hull Maintenance Technician 

4400-GS Gas Turbine Systems Technician 

4500-DC Damage Controlman 

4700-ML Molder 

5000-FN Fireman 

5080-CU Contructionman 

5100-EA Engineering Aid 

5280-UC Utilities Constructionman 

5300-CE Construction Electrician 

5380-EQ Equipmentman 
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Rate Code Occupational Title 

5500-CM Construction Mechanic 

5600-BU Builder 

5700-SW Steelworker 

5800-UT Utilitiesman 

6000-CN Constructionman 

6080-AF Aircraft Maintenance Technician 

6180-AV Avionics Technician 

6200-AD Aviation Machinists Mate 

6300-AT Aviation Electrons Technician 

6310-AX ASW Technician 

6400-AW Aviation ASW Operator 

6500-AO Aviation Ordnanceman 

6600-AC Air Controlman 

6700-AB Aviation Boatswains Mate 

6800-AE Aviation Electricians Mate 

6900-AM Aviation Structural Mechanic 

7000-PR Aircrew Survival Equipmentman 

7100-AG Aerographers Mate 

7200-TD Trademan 

7300-AK Aviation Storekeeper 

7400-AZ Aviation Maintenance Administrationman 

7500-AS Aviation Support Equipment Technician 

7600-PH Photographers Mate 

7700-PT Photographic Intelligence man 

7800-AN Airman 

8000-HM Hospital Corpsman 

8300-DT Dental Technician 

9999-ZZ Other 
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Occupation Rate Codes and Titles 

Sorted by Rate Title 

Rate Code      Occupational Title  

7100-AG Aerographers Mate 

6600-AC Air Controlman 

6080-AF Aircraft Maintenance Technician 

7000-PR Aircrew Survival Equipmentman 

7800-AN Airman 

6310-AX ASW Technician 

6400-AW Aviation ASW Operator 

6700-AB Aviation Boatswains Mate 

6800-AE Aviation Electricians Mate 

6300-AT Aviation Electrons Technician 

6200-AD Aviation Machinists Mate 

7400-AZ Aviation Maintenance Administrationman 

6500-AO Aviation Ordnanceman 

7300-AK Aviation Storekeeper 

6900-AM Aviation Structural Mechanic 

7500-AS Aviation Support Equipment Technician 

6180-AV Avionics Technician 

0100-BM Boatswains Mate 

4000-BT Boiler Technician 

5600-BU Builder 

1600-CT Communications Technician 

5300-CE Construction Electrician 

6000-CN Constructionman 

5500-CM Construction Mechanic 

5080-CU Contructionman 

4500-DC Damage Controlman 

1900-DP Data Processing Technician 

1010-DS Data Systems Technician 
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Rate Code Occupational Title 

8300-DT Dental Technician 

2100-DK Disbursing Clerk 

4100-EM Electricians Mate 

1000-ET Electronics Technician 

0350-EW Electronics Warfare Technician 

3800-EN Engineman 

5100-EA Engineering Aid 

5380-EQ Equipmentman 

0800-FT Fire Control Technician 

0700-FC Fire Controlman 

5000-FN Fireman 

4400-GS Gas Turbine Systems Technician 

0600-GM Gunners Mate 

8000-HM Hospital Corpsman 

4300-HT Hull Maintenance Technician 

3200-DM Illustrator Draftsman 

1100-IM Instrumentman 

2300-IS Intelligence Specialist 

4200-IC Interior Comm Electrician 

2600-JO Journalist 

1750-LN Legalman 

3100-LI Lithographer 

3900-MR Machinery Repairman 

3700-MM Machinists Mate 

0150-MA Master-at-Arms 

2200-MS Mess Management Specialist 

0900-MN Mineman 

0810-MT Missile Technician 

4700-ML Molder 

3300-MU Musician 
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Rate Code Occupational Title 

1400-NC Navy Counselor 

0450-OT Ocean Systems Technician 

0300-OS Operations Specialist 

1200-OM Opticalman 

9999-ZZ Other 

1800-PN Personnelman 

7600-PH Photographers Mate 

7700-PT Photographic Intelligence man 

2700-PC Postal Clerk 

1080-PI Precision Instrumentman 

0200-QM Quartermaster 

1500-RM Radioman 

2500-RP Religious Program 

3600-SN Seaman 

2490-SH Ships Serviceman 

0250-SM Signalman 

0400-ST Sonar Technician 

5700-SW Steelworker 

2000-SK Storekeeper 

0500-TM Torpedomans Mate 

7200-TD Trademan 

5280-UC Utilities Constructionman 

5800-UT Utilitiesman 

0610-WT Weapons Technician 

1700-YN Yeoman 
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Duty Platforms and Acronyms 

A total of 2,208 UICs are available in EPISYS version 1.0. UICs are grouped according 
to their platform type. 

Acronym Duty Platform 

cv 

CVN 

BB/CG 

CGN 

DD/FF 

DDN/FFN 

SURFACE 

ASSAULT 

SUPPORT 

REPLENSH 

CARGO 

PERSONNL 

SS 

SSN 

SSBN 

HOSPITAL 

AUX 

MISC 

OTHER 

ASHORE 

UNKNOWN 

Aircraft Carrier 

Aircraft Carrier, Nuclear 

Battleship/Cruiser 

Cruiser, Nuclear 

Destroyer/Frigate 

Destroyer/Frigate, Nuclear 

Small Surface Combatants 

Amphibious Assault 

Material Support 

Underway Replenishment 

Transport Cargo 

Transport Personnel 

Submarine 

Submarine Attack, Nuclear 

Submarine Ballistic Missile, Nuclear 

Hospital Ship 

Auxiliary/No-combatant 

Miscellaneous 

Other 

Ashore 

Unknown 
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Incidence/Prevalence 

Incidence — 1st Hospitalizations Only 

All Major Categories Separately 

Viral Diseases 
Bacterial Diseases 
Mycobacterial Diseases 
Rickettsial Diseases 
Chlamydial Diseases 
Sexually Transmitted Diseases 
Fungus Diseases 
Spirochete Caused Diseases 
Protozoal Diseases 
Ectoparasites 
Worm Caused Diseases 
Uncertain Etiology 
Neoplasms 
Endocrine/Nutrition/Metabolic Diseases 
Diseases of Blood/Blood-Forming Organs 
Mental Disorders 
Diseases of Nervous System/Sense Organs 
Diseases of Circulatory System 
Diseases of Respiratory System 
Diseases of Digestive System 
Diseases of Genitourinary System 
Complications of Pregnancy/Childbirth 
Diseases of Skin/Subcutaneous Tissue 
Diseases of Musculoskeletal System 
Congenital Anomalies 
Perinatal Morbidity/Mortality 
Symptomatic/Ill-Defined Conditions 
Accident/Poisoning/Violence 
Supplementary/Special Conditions 

Sex Categories Separately 

Male 
Female 

All Race Categories Separately 

White 
Black 
Other/Unspecified 
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Age (Standard Classes) Separately 

Ages 17—19 
Ages 20 — 21 
Ages 22 — 24 
Ages 25 — 29 
Ages 30 — 34 
Ages 35 — 39 
Ages 40 — 44 
Ages 45 — 61 

US Navy Only 

All Enlisted Grades Separately 

Enlisted-1 
Enlisted-2 
Enlisted-3 
Enlisted-4 
Enlisted-5 
Enlisted-6 
Enlisted-7 
Enlisted-8 
Enlisted-9 

All Occupation Rates Separately 

0100-BM Boatswains Mate 
0150-MA Master-at-Arms 
0200-QM Quartermaster 
0250-SM Signalman 
0300-OS Operations Specialist 
0350-EW Electronics Warfare Technician 
0400-ST Sonar Technician 
0450-OT Ocean Systems Technician 
0500-TM Torpedomans Mate 
0600-GM Gunners Mate 
0610-WT Weapons Technician 
0700-FC Fire Controlman 
0800-FT Fire Control Technician 
0810-MT Missile Technician 
0900-MN Mineman 
1000-ET Electronics Technician 
1010-DS Data Systems Technician 
1080-PI Precision Instrumentman 
1100-IM Instrumentman 
1200-OM Opticalman 
1400-NC Navy Counselor 
1500-RM Radioman 
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1600-CT Communications Technician 
1700-YN Yeoman 
1750-LN Legalman 
1800-PN Personnelman 
1900-DP Data Processing Technician 
2000-SK Storekeeper 
2100-DK Disbursing Clerk 
2200-MS Mess Management Specialist 
2300-IS Intelligence Specialist 
2490-SH Ships Serviceman 
2500-RP Religious Program 
2600-JO Journalist 
2700-PC Postal Clerk 
3100-LI Lithographer 
3200-DM Illustrator Draftsman 
3300-MU Musician 
3600-SN Seaman 
3700-MM Machinists Mate 
3800-EN Engineman 
3900-MR Machinery Repairman 
4000-BT Boiler Technician 
4100-EM Electricians Mate 
4200-IC Interior Comm Electrician 
4300-HT Hull Maintenance Technician 
4400-GS Gas Turbine Systems Technician 
4500-DC Damage Controlman 
4700-ML Molder 
5000-FN Fireman 
5080-CU Contructionman 
5100-EA Engineering Aid 
5280-UC Utilities Constructionman 
5300-CE Construction Electrician 
5380-EQ Equipmentman 
5500-CM Construction Mechanic 
5600-BU Builder 
5700-SW Steelworker 
5800-UT Utilitiesman 
6000-CN Constructionman 
6080-AF Aircraft Maintenance Technician 
6180-AV Avionics Technician 
6200-AD Aviation Machinists Mate 
6300-AT Aviation Electrons Technician 
6310-AX ASW Technician 
6400-AW Aviation ASW Operator 
6500-AO Aviation Ordnanceman 
6600-AC Air Controlman 
6700-AB Aviation Boatswains Mate 
6800-AE Aviation Electricians Mate 
6900-AM Aviation Structural Mech 
7000-PR Aircrew Survival Equipmentman 
7100-AG Aerographers Mate 
7200-TD Trademan 
7300-AK Aviation Storekeeper 
7400-AZ Aviation Maintenance Administrationman 
7500-AS Aviation Support EquipmenfTechnician 

Appendix E EPISYS Default Variables 84 



7600-PH Photographers Mate 
7800-AN Airman 
8000-HM Hospital Corpsman 
8300-DT Dental Technician 
9999-ZZ Other 

All Duty Platforms Separately 

Aircraft Carrier 
Aircraft Carrier, Nuclear 
Battleship/Cruiser 
Cruiser, Nuclear 
Destroyer/Frigate 
Small Surface Combatants 
Amphibious Assault 
Material Support 
Underway Replenishment 
Transport Cargo 
Transport Personnel 
Submarine 
Submarine Attack, Nuclear 
Submarine Ballistic Missile, Nuclear 
Auxiliary/Non-combatant 
Miscellaneous 
Other 
Ashore 

Medical Facilities Combined 

National Medical Center, Bethesda MD 
Medical Command, Great Lakes IL 
Medical Command, Oakland CA 
Medical Command, San Diego CA 
Hospital, Beaufort SC 
Hospital, Bremerton WA 
Hospital, Cherry Point NC 
Hospital, Charleston SC 
Hospital, Corpus Cristi TX 
Hospital, Groton CT 
Hospital, Great Lakes IL 
Hospital, Guam 
Hospital, Guantanamo Bay CU 
Hospital, Jacksonville FL 
Hospital, NAS Keflavik IC 
Hospital, Keflavik IC 
Hospital, Camp Lejeune NC 
Hospital, Lemoore CA 
Hospital, Millington TN 
Hospital, Naples IT 
Hospital, Newport RI 
Hospital, Norfolk VA 
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Hospital, Oak Harbor WA 
Hospital, Oakland CA 
Hospital, Okinawa JA 
Hospital, Orlando FL 
Hospital, Patuxent River MD 
Hospital, Camp Pendleton CA 
Hospital, Pensacola FL 
Hospital, Rota SP 
Hospital, Roosevelt Roads PR 
Hospital, Sigonella IT 
Hospital, San Diego CA 
Hospital, TwentyNine Palms CA 
Hospital, Yokosuka JA 
Branch Clinic, Adak AK 
Branch Clinic Naval Home, Gulfport MS 
Branch Clinic, Iwakuni JA 
Regional Medical Center, Jacksonville FL 
Regional Medical Center, Long Beach CA 
Regional Medical Center, Portsmouth VA 
Regional Medical Center, Subic Bay RP 
Medical Clinic, Quantico VA 
Medical Clinic, Philadelphia PA 

Inclusive Dates 

1 January 1980 through 31 December 1994 
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Making the Denominator Files 

The creation of EPISYS.DEN proceeds in two steps.  The first step is carried out on the VAX and 
involves counting all one, two, and three variable interactions in yearly files with the following format: 

Variable Type Width 

(skip) — 9 
treatment year integer 2 
(skip) 2 
grade integer 1 
rate char 2 
(skip) 14 
sex char 1 
race char 1 
age integer 2 
(skip) 6 
branch integer 2 
(skip) 15 
duty UIC char 5 

There are four FORTRAN programs, necessitated by the size of the data base being processed. The 
intermediate data files created by these programs contain two fields per record: an index (indicating 
position in EPISYS.DEN) and the count. The complete set of intermediate files is transferred to the PC. 

There is an important issue to be considered at this point in denominator data file creation: that is the 
necessity for separate DEN files for each year (1980-1994). This necessity is determined by a technique 
related to analysis of variance and based on detecting yearly differences in trends among population 
totals, main effect variables, and variable interactions. The purpose of the analysis is to detect any 
statistically significant trends present in the demographic denominator data set. If this is found to show 
significant differences, then each main effect variable (sex, race, age, branch, grade, rate, platform, ocean) 
is tested. For instance, in testing the main effect "sex", the yearly numbers of males and females in the 
population are tested for differences in trends among years. If any main effects are found to show 
significant differences, then two and three variable interactions involving the significant variables are 
tested. A significant yearly population total means that yearly differences in total population must be 
included in the denominator data files. In turn, any significant yearly differences in main effect, variables 
or variable interactions means that those yearly differences must also be included in the denominator data 
files. It should be noted that yearly differences were significant for the current EPISYS demographic 
denominator data, but that no main effect or interactions were significant. Therefore, only yearly 
differences are included in the current EPISYS denominator data set and only one DEN file was created. 

The final step in creating EPISYS.DEN is to read each of the intermediate data files (described above) and 
sum them to the appropriate indices. The final data file (EPISYS.DEN) therefore contains one record for 
each main effect, two variable and three variable interaction in the data set. The current file contains 
339,513 records. The file is binary and is ordered with all main effects first followed by all two variable 
interactions and then all three variable interactions. Along with EPISYS.DEN, another file is created that 
contains total population counts for each year (EPISYS.MYA). The data in this file is used to adjust 
calculated denominators for yearly differences. 

After EPISYS.DEN is created, an index file (EPISYS.NDX) is also created. This file has in each record 
an eight digit code (indicating the interaction), an index (the record number in EPISYS.DEN containing 
the first count for the interaction), and a count (the number of records in EPISYS.DEN for the interaction). 

Person-years are calculated by summing the individual counts for main effects and each of the two and 
three variable interactions across each quarter per year. The data for the denominator are provided by 
quarter, resulting in a resolution of four months. 
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Calculating Confidence Intervals 

There are two types of confidence intervals used in EPISYS: confidence intervals about incidence rates 
and confidence intervals about standardized incidence ratios. Both are handled in a very similar manner 
using the Incomplete Gamma Distribution. In the case of incidence rates, the numerator is treated as the 
sum of N random variables where each variable is either 0 or 1 depending on whether the corresponding 

r = 

N N 

i=l i=l 

N 

i = ] 

N (1) 

member of the population has an incidence of the condition being analyzed. N is the total population size 
and is therefore a constant with no probability distribution. The incidence ratio is therefore 
In this case, r < 1 and the following Incomplete Gamma Function is used to represent the distribution 

ofr: 

G(rN|a,l) 
T(a+1) i+E 

\T\ (a+l)(a+2) ... (a+i) 
(2) 

where a is the numerator of equation (1) (the degrees of freedom) and the sum on the right hand side of 
equation (2) is repeated until the contribution of a new term is less than some preset tolerance. The 
values of rN found by a halving the interval technique correspond to, for instance for 0.95 confidence 
limits, the 0.025 and 0.975 cumulative probability levels of the prescribed Incomplete Gamma 
distirbution. The upper and lower confidence limits are then the rN values corresponding to the 0.025 
and 0.975 cumulative probabilities, respectively, divided by N. This method is possible in large part 
because the rate r is constrained in the interval [0,1]. 

Standardized incidence ratios are a rate divided by a predetermined constant and are not constrained on 
the interval [0,1 ]. The same method is used as above except that the following continued fraction is used 
to calculate the Incomplete Gamma Function. 

G(rN|a,l) = 1 
T(a) 

j_  U_l_  2-& _2_ 
x+    1+    x+    1 +   x + (3) 

The upper and lower confidence limits areagain the rN values corresponding to the 0.025 and 0.975 
cumulative probabilities, respectively, divided by N. 

The Gamma function itself is calculated as follows: 

r(a + l) = (a+Y+0.5)"*0-5 e .«*0.5      -(U*Y*0.5) 

fl+1 

C2 

a+N 
(4) 
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Where N = 6,y = 5, and the constants are as follows: 

c0 = 1.0 

c, = 76.18009173 
c2 = -86.50532033 
c3 = 24.01409822 (5) 

c4 = -1.231739516 
c5 = 0.00120858003 

c. = 0.0000053662827465 

The best references for the use of our methods for estimation of probabilities associated with Poisson 
processes are the following: 

Kennedy, W. J. & J. E. Gentle. (1980). Statistical Computing. New York: Marcel Dekker. 

Feller, W. (1957). An Introduction to probability theory and its applications, volume. I. (2nd ed). New 
York: John Wiley and Sons. 

Other references are: 

Abramowitz, M. & I. Stegun. (1964). Handbook of mathematical functions. Washington, D.C.: U.S. 
Government Printing Office. 

Bhattacharjee, G.P. (1970). The incomplete gamma integral. Applied Statistics, 19, 285-287. 

Ling, R.F. (1978). A study of the accuracy of some approximations for t, X2, and F tail probabilities. 
Journal of American Statistics Association, 73, 274-283. 
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